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RESUMEN DEL PROYECTO  

Este Trabajo de Fin de Máster presenta una metodología para el despliegue estratégico de 

infraestructura de recarga para camiones eléctricos a lo largo del Corredor Mediterráneo. 

Mediante la integración de análisis espacial, modelado basado en la demanda y técnicas de 

dimensionamiento técnico, el estudio identifica y prioriza ubicaciones óptimas, dando como 

resultado una red de 12 estaciones de recarga capaces de atender la demanda proyectada del 

transporte de mercancías para el año 2030. El marco propuesto es adaptable a diferentes 

niveles de adopción del camión eléctrico y puede extenderse a otros corredores logísticos en 

España y Europa. 

Palabras clave: Camiones eléctricos, Infraestructura de recarga, Análisis espacial  

1. Introducción 

La transición hacia un transporte de mercancías sostenible es un objetivo central de la 

Unión Europea, que ha establecido metas ambiciosas para la reducción de emisiones de 

gases de efecto invernadero en el sector del transporte por carretera. Los camiones 

eléctricos representan una tecnología clave en este proceso, aunque su adopción 

generalizada depende del desarrollo de una infraestructura de recarga extensa y fiable, 

especialmente a lo largo de los principales corredores logísticos. 

Este Trabajo de Fin de Máster se centra en el Corredor Mediterráneo, un eje fundamental 

para el transporte de mercancías en España. El estudio presenta una metodología que 

combina análisis espacial, modelado de demanda y dimensionamiento técnico para 

identificar y optimizar la localización y capacidad de las estaciones de recarga para 

camiones eléctricos. El objetivo es proporcionar un marco práctico de planificación de 

infraestructuras que impulse la electrificación del transporte de mercancías en este 

corredor y pueda replicarse en otras regiones. 

2. Definición del proyecto 

El objetivo principal de este Trabajo de Fin de Máster es diseñar una red optimizada de 

estaciones de recarga para camiones eléctricos de gran tonelaje a lo largo del Corredor 

Mediterráneo español. El proyecto se basa en una metodología orientada por la demanda 

y fundamentada en el análisis espacial, que integra datos reales de flujos de tráfico, la 

distribución actual de paradas de camiones y los requisitos normativos previstos. 

El alcance del proyecto incluye la identificación de ubicaciones candidatas para las 

estaciones de recarga, la aplicación de un modelo de optimización de localización para 

priorizar y seleccionar los puntos más estratégicos, así como el dimensionamiento 

técnico de cada estación en función de la demanda estimada y las limitaciones operativas. 

La metodología también contempla la viabilidad económica mediante la estimación del 



coste total de la infraestructura en distintos escenarios de adopción del camión eléctrico, 

en línea con los objetivos marcados por la Unión Europea para 2030. 

Combinando herramientas de análisis espacial (QGIS), un modelo gravitacional de 

atractivo logístico y teoría de colas para el dimensionamiento de cargadores, el proyecto 

busca ofrecer una solución flexible, escalable y transferible. El objetivo final es apoyar 

la transición hacia un transporte de mercancías libre de emisiones, no solo en el Corredor 

Mediterráneo, sino también como marco replicable en otros corredores logísticos de 

España y Europa. 

3. Descripción del modelo/sistema/herramienta 

La metodología desarrollada en este trabajo integra herramientas de análisis espacial, 

optimización de localización y dimensionamiento técnico para diseñar una red eficaz de 

estaciones de recarga para camiones eléctricos. Utilizando QGIS, se representan en el 

mapa datos reales sobre flujos de camiones y áreas de descanso, con el fin de identificar 

ubicaciones candidatas a lo largo del Corredor Mediterráneo. 

Posteriormente, se aplica un modelo gravitacional para seleccionar los puntos más 

estratégicos, maximizando la cobertura y minimizando redundancias. Cada estación 

seleccionada se dimensiona mediante teoría de colas aplicada a los cargadores rápidos, 

garantizando un funcionamiento eficiente en situaciones de alta demanda. Los 

cargadores lentos, destinados a paradas nocturnas o de larga duración, se dimensionan 

mediante un modelo estático de ocupación. Este enfoque da lugar a un marco de 

planificación flexible y escalable, adaptable a datos actualizados o aplicable en otros 

corredores logísticos. 

 

Figure 1. Diagrama que muestra la metodología de cinco pasos para la planificación de infraestructura de 

recarga para camiones eléctricos. 

4. Resultados 

La aplicación de la metodología propuesta al Corredor Mediterráneo permitió identificar 

12 ubicaciones óptimas para estaciones de recarga de camiones eléctricos, seleccionadas 

a partir de un conjunto inicial de 18 candidatas. Estos puntos fueron escogidos en función 

de la demanda de transporte de mercancías proyectada para 2030, su accesibilidad y su 

valor estratégico dentro del corredor. La combinación del análisis espacial con el modelo 

gravitacional permitió configurar una red bien distribuida, que maximiza la cobertura y 

minimiza la superposición entre estaciones. 



Cada estación fue dimensionada técnicamente para cumplir con los objetivos de tiempo 

de servicio y tasa de utilización, lo que dio lugar a una asignación diferenciada de 

cargadores rápidos y lentos, según los patrones de tráfico esperados. Se analizó el coste 

total de la infraestructura en distintos escenarios de adopción del camión eléctrico, 

demostrando que una estrategia de inversión escalonada, comenzando con una 

penetración del 5 % de la flota y ampliándose a medida que crece la adopción, puede 

atender eficazmente el aumento progresivo de la demanda. La metodología se mostró 

robusta y adaptable, ofreciendo una solución práctica para futuras expansiones en otras 

regiones o corredores logísticos. 

 

Figure 2.  Ubicaciones finales de las 12 futuras estaciones de recarga eléctrica para vehículos pesados a lo 

largo del Corredor Mediterráneo en España. 

5. Conclusiones 

Este estudio demuestra que una metodología basada en datos y orientada por la demanda 

permite planificar de forma eficiente la infraestructura de recarga para camiones 

eléctricos en corredores logísticos clave. Al priorizar ubicaciones estratégicas y 

dimensionar cada estación según las necesidades proyectadas, el marco propuesto 

favorece una transición escalable y rentable hacia un transporte de mercancías libre de 

emisiones. Este enfoque es adaptable a la evolución del mercado y puede replicarse en 

otras regiones, contribuyendo así a los objetivos generales de movilidad sostenible y 

cumplimiento normativo. 
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ABSTRACT  

This Master’s Thesis presents a methodology for the strategic deployment of electric truck 

charging infrastructure along the Mediterranean Corridor. By integrating spatial analysis, 

demand-based modeling, and technical sizing methods, the study identifies and prioritizes 

optimal locations, resulting in a network of 12 charging stations capable of meeting projected 

freight transport demand by 2030. The proposed framework is adaptable to different levels 

of electric truck adoption and can be extended to other logistics corridors in Spain and 

Europe. 

Keywords: Electric trucks, Charging infrastructure, Spatial analysis,  

1. Introduction 

The transition towards sustainable freight transport is a central goal for the European 

Union, which has established ambitious targets for reducing greenhouse gas emissions 

in the road transport sector. Electric trucks represent a key technology in this transition, 

but their widespread adoption depends on the development of an extensive and reliable 

charging infrastructure, especially along major logistics corridors. 

This Master’s Thesis focuses on the Mediterranean Corridor, a vital axis for goods 

movement in Spain. The study presents a methodology that combines spatial analysis, 

demand modeling, and technical sizing to identify and optimize the location and capacity 

of electric truck charging stations. The aim is to provide a practical framework for 

infrastructure planning that supports the electrification of freight transport in this corridor 

and can be replicated in other regions. 

2. Definition of the project 

The main objective of this Master's Thesis is to design an optimized network of electric 

charging stations for heavy-duty trucks along the Spanish Mediterranean Corridor. The 

project is based on a demand-driven and spatially informed methodology that integrates 

real traffic flow data, the current distribution of truck stops, and future regulatory 

requirements. 

The scope of the project includes the identification of candidate locations for charging 

stations, the application of a location optimization model to prioritize and select the most 

strategic sites, and the technical sizing of each station according to projected demand and 

operational constraints. The methodology also considers economic feasibility by 

estimating the total infrastructure cost for different electric truck adoption scenarios, in 

line with European Union targets for 2030. 

By combining spatial analysis tools (QGIS), a gravitational attractiveness model, and 

queueing theory for charger sizing, the project aims to deliver a flexible, scalable, and 



transferable solution. The ultimate goal is to support the transition to zero-emission 

freight transport, not only in the Mediterranean Corridor but also as a replicable 

framework for other logistics corridors in Spain and Europe. 

3. Description of the model  

The methodology developed in this thesis integrates spatial analysis, location 

optimization, and technical sizing tools to design an effective charging network for 

electric trucks. Using QGIS, real data on truck flows and rest areas are mapped to identify 

candidate sites along the Mediterranean Corridor. 

A gravitational model is then applied to select the most strategic locations, maximizing 

coverage and minimizing redundancy. Each selected station is sized with queueing 

theory applied to fast chargers, ensuring efficient operation under peak demand. Slow 

chargers, intended for overnight or long-duration stops, are dimensioned using a static 

occupancy model. This approach results in a flexible and scalable planning framework, 

adaptable to updated data or application in other logistics corridors. 

 

Figure 3. Diagram showing the five-step methodology for planning electric truck charging infrastructure 

 

4. Results 

Applying the proposed methodology to the Mediterranean Corridor led to the 

identification of 12 optimal locations for electric truck charging stations, selected from 

an initial set of 18 candidates. These sites were chosen based on projected freight demand 

for 2030, accessibility, and strategic value along the corridor. The combination of spatial 

analysis and the gravitational model ensured a well-distributed network that maximizes 

coverage and minimizes overlap. 

Each station was technically sized to meet service time and utilization targets, resulting 

in a differentiated allocation of fast and slow chargers according to expected traffic 

patterns. The total cost of infrastructure was analyzed under several electric truck 

adoption scenarios, demonstrating that a phased investment strategy—starting at 5% 

fleet penetration and scaling up as adoption grows—can efficiently accommodate 

increasing demand. The methodology proved robust and adaptable, offering a practical 

solution for future expansion in other regions or corridors. 



 

Figure 4. Final 12 locations of future electric charging stations for heavy-duty vehicles along the 

Mediterranean Corridor in Spain. 

5. Conclusions 

This study demonstrates that a data-driven and demand-oriented methodology enables 

the efficient planning of electric truck charging infrastructure on key logistics corridors. 

By prioritizing strategic locations and sizing each station according to projected needs, 

the proposed framework supports a scalable and cost-effective transition to zero-

emission freight transport. The approach is adaptable to evolving market conditions and 

can be replicated in other regions, contributing to the broader goals of sustainable 

mobility and regulatory compliance. 
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Chapter 1.  INTRODUCCIÓN 

In the coming years, electric trucks are expected to gain a significant presence on European 

roads, driven by the growing interest in reducing pollutant emissions and the potential for 

lower operating costs. Several factors support this trend. On the one hand, technological 

advancements in battery manufacturing are enabling electric trucks to offer greater range 

and shorter charging times, making them increasingly competitive compared to diesel trucks. 

On the other hand, European Union policies aimed at combating climate change are 

accelerating the adoption of cleaner alternatives by setting increasingly stringent emission 

reduction targets. 

Furthermore, the European Union aims to reduce pollutant emissions among its member 

states, noting that approximately 6.25% of greenhouse gases originate from heavy 

commercial vehicles. In this context, replacing diesel trucks with electric models has 

emerged as an effective response to reducing the transport sector's carbon footprint. 

Although the initial investment in an electric truck may be higher, the lower long-term 

maintenance costs and the lower price of electricity compared to fossil fuels contribute to a 

gradual return on investment. 

As a result, the transition to electric trucks is emerging as an ideal solution for meeting the 

targets set out in the European Climate Law, which requires member states to adopt concrete 

measures to achieve climate neutrality in the coming decades. In this way, electric trucks not 

only help mitigate environmental impact but also pave the way for a cleaner and more 

efficient future in freight transport. 

However, as of today, neither the European Union nor Spain possesses the infrastructure 

necessary to support the large-scale deployment of electric trucks on their roads. Significant 

investment is still needed in charging facilities and in the modernization of the electrical 

grid. Therefore, the objective of this study is to adapt the Mediterranean Corridor to enable 

efficient circulation of these vehicles, meeting recharging needs while complying with the 

European Union’s “Regulation on the Deployment of Alternative Fuels Infrastructure.” 
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Specifically, this study proposes a comprehensive analysis of the logistics routes along the 

Mediterranean Corridor, with the aim of identifying the optimal locations for building 

electric charging stations for heavy-duty vehicles. The potential demand for charging will 

be assessed to appropriately size both the number of charging points and the power required 

to support freight transport operations. 

Finally, a strategic plan will be developed outlining the selected locations, the total power 

capacity needed, and the power distribution per charger. This approach will facilitate a 

coordinated transition toward electrified heavy transport, promoting the adoption of cleaner 

mobility solutions while simultaneously reducing the sector’s carbon footprint. In doing so, 

the study not only aligns with the objectives set by European regulations but also fosters 

innovation and strengthens the competitiveness of transport companies in an increasingly 

sustainability-driven market. 

1.1 .PROJECT MOTIVATION 

As outlined in the previous sections, the electrification of heavy-duty transport is a necessary 

step toward achieving the European Union's climate goals. While there have been significant 

technical advancements, corporate commitments, and increasingly clear legislation, such as 

the AFIR regulation, the charging infrastructure for electric trucks remains insufficient. 

The Mediterranean Corridor is one of the country’s main logistical arteries, connecting key 

industrial regions from Catalonia to Murcia. However, the lack of a charging network 

tailored to electric heavy-duty vehicles along this corridor jeopardizes the feasibility of its 

electrification in the short and medium term. The issue lies not only in the scarcity of 

charging points, but also in their suboptimal placement and the absence of clear technical 

criteria for their proper sizing. 

Existing European-level studies, such as the one conducted by the Fraunhofer Institute and 

Amazon Europe (2024), have demonstrated that an efficient charging network does not 

require uniform coverage, but rather planning based on actual demand and the specific 

capacity of each location. Nonetheless, these analyses have been carried out at a continental 
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scale and do not address the territorial and logistical specificities of corridors such as the one 

in Spain. 

For all these reasons, this project aims to apply a demand-based optimization methodology 

to the specific case of the Mediterranean Corridor. Using spatial analysis tools (QGIS) and 

integrating real data layers (truck stops, logistics hubs, traffic flows), the goal is to develop 

a realistic and efficient proposal aligned with European regulations. 

This initiative addresses both an urgent technical need and a strategic opportunity: to 

facilitate the energy transition of freight transport in one of Spain’s most active regions, 

while also contributing valuable insights for future public and private planning decisions. 

1.2 DEFINITION OF THE PROJECT 

1.2.1 JUSTIFICATION 

This Master's Thesis responds to that need by proposing a replicable methodology to identify 

and dimension the most relevant points for the initial deployment of truck charging stations 

along the Mediterranean Corridor—one of the country’s most critical logistics routes. The 

study integrates spatial analysis tools (QGIS), a demand-based gravitational model to 

optimize location selection, and a queueing theory model (M/M/s) to properly size the 

infrastructure based on estimated usage. 

The selection of optimal locations is grounded in projected demand (Fraunhofer ISI, 2024), 

existing infrastructure data (ACEA, 2025), and regulatory alignment (European Comission, 

2021) The gravitational model not only considers the attractiveness of each point but also 

incorporates a corrective term to penalize excessive proximity between stations, thus 

minimizing redundancy. Once the 12 most strategic locations were selected, demand was 

estimated at each station, and the number of fast and slow chargers was determined using a 

combination of queueing theory and static occupancy modeling. 

This technical approach is also highly flexible: it can be adapted as real-world data becomes 

available—such as updated traffic flows, adoption rates, or power grid limitations—without 
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requiring a complete reanalysis. Furthermore, the final cost estimation includes a sensitivity 

analysis under different electric truck penetration scenarios (5%, 7%, 10%, and 15%). While 

a 7% penetration rate is the most likely scenario by 2030, the actual rate remains uncertain. 

The analysis shows that the system can begin with a more limited investment to meet 5% 

demand and scale progressively as adoption increases, simply by adding chargers to the same 

sites. 

 

From an economic perspective, identifying optimal locations helps avoid costly oversizing 

or underutilization of infrastructure. Environmentally, this network supports national 

decarbonization goals, as road freight accounts for over 25% of transport-sector emissions 

in Spain. By providing a technically rigorous and regulation-compliant deployment model, 

this project contributes to a more sustainable and efficient freight mobility system in 

alignment with both the European Green Deal and Spain’s National Integrated Energy and 

Climate Plan (Ministerio para la Transición Ecológica y el Reto Demográfico, 2020). 

In short, this work is justified by the legal obligation to meet EU targets, the urgency of 

starting infrastructure deployment, the need to prioritize high-impact investments, and the 

practical value of providing a data-driven framework for future planning. 

1.2.2 OBJECTIVES 

The main objective of this master’s thesis is the design of a network of electric charging 

stations for heavy-duty trucks along the Mediterranean Corridor, following a methodology 

based on real freight transport demand and the use of spatial analysis tools. 

By adapting a leading European study, the aim is to apply an optimization model at a regional 

scale to identify optimal locations and assess their technical and strategic feasibility. To 

achieve this, traffic data, current truck stop locations, and key logistics points will be 

integrated in order to properly size the charging infrastructure required to support the 

electrification of freight transport in this key section of Spain’s logistics network. 
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Chapter 2.  STATE OF THE ART 

2.1 SECTOR OVERVIEW AND POLICY FRAMEWORK 

In recent years, various institutions, such as Bloomberg, have forecasted that by 2030, the 

cost of electric trucks will be more competitive than that of their diesel counterparts. To 

accurately assess the viability of each option, the Total Cost of Ownership (TCO) tool is 

used. This metric considers not only the purchase price but also maintenance expenses, 

energy or fuel consumption, and vehicle depreciation over its useful life. 

According to Bloomberg (McKerracher, 2024), battery prices have shown a significant 

downward trend in recent years. Specifically, in 2023, they dropped by 39%, reaching 

approximately $100 per kWh. If this trend continues, prices are expected to fall to $80 per 

kWh by 2030. In addition to the reduction in battery costs, increased production volumes 

and technological improvements in electric truck manufacturing are contributing to the 

overall decrease in prices. 

Other studies, such as that by the International Council on Clean Transportation (Rodríguez, 

2023), support these projections. Figure 5 compares of cost per kilometer by truck type in 

2030 compares the cost per kilometer of various truck alternatives projected for 2030, 

showing that electric trucks could be up to 22% more cost-effective per kilometer than their 

diesel equivalents. This cost advantage would stem not only from the reduced maintenance 

requirements of electric motors but also from public policies aimed at discouraging pollutant 

emissions, such as carbon taxes or low-emission zones in urban areas. 
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Figure 5. Comparison of cost per kilometer by truck type in 2030. Source: International Council on Clean 

Transportation  

According to projections for 2040, electric trucks are expected to continue leading in terms 

of profitability, although hydrogen-powered trucks, also known as fuel cell vehicles, are 

anticipated to emerge as the second most cost-effective alternative. Beyond 2050, 

projections become less conclusive. It is estimated that hydrogen trucks could surpass 

electric ones in competitiveness, provided that green hydrogen can be produced at scale and 

at low cost. Conversely, if battery prices continue to fall and their energy density increases, 

electric trucks may retain their advantage. In any scenario, the transition toward low-carbon 

freight transport systems will require the development of public policies that promote 

research, production, and large-scale deployment of these technologies. 

Major truck manufacturers such as Iveco, Volvo, and Scania are already launching electric 

models to meet sustainability requirements and comply with European emission reduction 

regulations. Volvo, for instance, has announced that by 2040, all of its vehicles will be zero-

emission, in line with the European Union’s target of achieving climate neutrality by the 

same year (Volvo, s.f.). These corporate commitments reflect both EU policies promoting 

transport electrification and the growing demand for cleaner, more efficient logistics 

solutions. Through such efforts, the trucking industry is moving toward a more sustainable 

future, aligning with market trends and institutional goals to reduce the environmental 

impact of freight transport. 
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At present, the vast majority of trucks operating on European roads are powered by 

conventional diesel engines. In fact, according to data from the European Automobile 

Manufacturers’ Association, electric trucks currently account for just 0.1% of the total fleet 

in the European Union, highlighting the limited adoption of this technology to date (ACEA, 

2025). 

Several factors help explain why a widespread shift to electric mobility in this sector has not 

yet occurred: 

• Limited range: Although battery performance has improved substantially in recent 

years, electric trucks still fall short of matching diesel trucks in terms of long-distance 

capabilities. However, starting in 2025, new models are expected to offer ranges of 

approximately 400 to 500 kilometers—sufficient to cover the 4.5 hours of driving 

permitted before mandatory rest breaks. This advancement could eliminate one of 

the main barriers to electric truck adoption. 

• Charging time: Another critical issue is battery recharging, which can require longer 

stops than the 45-minute rest period mandated by EU regulations. Nevertheless, the 

introduction of fast-charging systems such as the Megawatt Charging System (MCS) 

could reduce recharging times to under 45 minutes, aligning with regulatory breaks 

and minimizing operational inefficiencies. 

• High initial investment cost: The purchase price of electric trucks, along with the 

cost of installing charging infrastructure, represents a significant barrier to entry, as 

it currently exceeds that of equivalent diesel models. Still, as technology matures and 

demand grows, prices are expected to gradually decline. 

• Lack of infrastructure: The limited number of charging stations in Europe 

complicates route planning for long-haul journeys and threatens the continuity of 

freight services. Expanding this infrastructure is precisely the focus of this study, 

aiming to pave the way for a broader adoption of electric truck fleets. 
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In Spain specifically, the charging infrastructure for electric trucks remains in its early 

stages. While some charging points exist along strategic corridors such as the AP-7 

(Mediterranean), A-2 (Madrid–Barcelona), and A-6 (Northwest), most are designed for 

passenger vehicles and lack the power capacity required for trucks. Nevertheless, important 

steps have been taken, including a dedicated charging hub in Sangonera la Seca (Murcia) to 

serve heavy-duty vehicles, and a planned project in Zaragoza to install truck-specific 

charging stations aimed at improving connectivity across the northeastern region of the 

country. 

This lack of dedicated infrastructure for heavy-duty vehicles poses a significant challenge 

for transport companies seeking to electrify their fleets. 

On a broader level, the European Union introduced the “Fit for 55” legislative package in 

2021, which aims to reduce greenhouse gas emissions by 55% by 2030 compared to 1990 

levels, and to achieve climate neutrality by 2050. To this end, the package revises existing 

legislation and proposes new measures across multiple sectors. Some components of “Fit for 

55” have already been approved, while others are still undergoing the legislative process 

(European comission, 2021). 

In relation to this study, particular attention must be given to the new AFIR regulation—

Alternative Fuels Infrastructure Regulation (European comission, 2023). This regulation 

replaces the earlier AFID directive—Alternative Fuels Infrastructure Directive, adopted in 

2014 (European comission, 2014). AFID was the European Union’s first legislative measure 

aimed at promoting the deployment of electric charging stations for all types of vehicles. 

Subsequently, in 2023, AFIR was formally adopted to establish clearer, directly applicable 

targets for Member States. 

One of the main innovations introduced by AFIR is the differentiation between charging 

stations designed for heavy-duty vehicles and those intended for other types of vehicles—a 

distinction not considered in the earlier directive. The category of heavy-duty vehicles 

includes trucks, which are the central focus of this study. 
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AFIR sets specific targets for (ISI, 2024) coverage and minimum power capacity along the 

Trans-European Transport Network (TEN-T), a large-scale European Union initiative that 

coordinates and improves transportation networks (including roads, railways, waterways, 

and ports) to enhance regional connectivity and promote faster, safer, and more sustainable 

movement of people and goods. This study focuses specifically on the road infrastructure 

within the TEN-T, as it constitutes the main corridor for heavy-duty vehicle traffic. 

Below are some of the most significant milestones established by AFIR: 

• By 2025: At least 15% of the TEN-T must be equipped with truck charging 

infrastructure, with a minimum total power capacity of 1,400 kW per area, and at 

least one charging point of 350 kW. 

• By 2027: The coverage must expand to 50% of the TEN-T, reaching a minimum total 

power of 2,800 kW per area, with at least two chargers of 350 kW. 

• By 2030: AFIR mandates the presence of at least one truck charging station every 60 

km along the TEN-T, with a minimum total power capacity of 3,600 kW and at least 

two chargers of 350 kW. 

Table 1. European Regulation on the deployment of high-power charging points. 

summarizes the various targets set by the European Union, along with their corresponding 

implementation deadlines. 

 

 

 

 

 

 

 

Table 1. European Regulation on the deployment of high-power charging points. 

By the end  

of the year 

% of TEN-T 

network covered  

Minimum 

Total Power 

Minimun Power 

charger(s) 

2025 15% 1.400 KW 1x 350KW 

2027 50% 2.800KW 2x 350KW 

2030 Cada 60 KM 3.600KW 2x 350KW 
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When AFIR refers to a percentage of coverage, it indicates the proportion of kilometers 

within the TEN-T network that must be equipped with suitable charging areas for trucks at 

regular intervals. In practice, this means that within those designated segments, the charging 

stations must comply with the regulation’s requirements for power output and spacing. 

However, certain exceptions are allowed in low-traffic areas or regions with geographic 

constraints, where Member States may request extended deadlines or specific conditions. 

These obligations are designed to ensure the availability of high-power charging points for 

heavy-duty vehicles, so that limited range and long charging times no longer pose a barrier 

to the electrification of trucks on long-distance routes. 

2.2 DESCRIPTION OF THE TECHNOLOGIES 

In the context of this project, QGIS serves as an essential tool, as it enables the integration, 

visualization, and simultaneous analysis of the various spatial data sources collected, thereby 

facilitating the optimal planning of charging infrastructure for electric trucks. 

QGIS is an open-source Geographic Information System (GIS) that enables the 

visualization, analysis, and editing of geospatial data. This software provides powerful tools 

for managing multiple layers of geographic information, conducting advanced spatial 

analyses, and creating interactive maps that support decision-making across various fields, 

including transportation, urban planning, and energy infrastructure, among others. 

The primary objective of using QGIS in this study is to bring together within a single 

analytical environment two main sources of geographic information related to the 

electrification of heavy-duty transport: 

• Data from the Fraunhofer ISI study (20): The strategic locations recommended in 

this study are available in digital format through its online publication and associated 

documents. These data include the precise geographic coordinates of approximately 

2,700 locations identified as strategic for the deployment of charging stations across 

Europe. 
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• Data from the ACEA interactive resource ("Interactive maps: Electric trucks stop 

locations in Southern Europe"): This resource is an interactive map displaying the 

current stop locations commonly used by trucks, primarily diesel vehicles. However, 

the data are not available for direct download in GIS-compatible formats, 

necessitating the creation of a custom Excel file for the project. In this file, all 

locations shown by ACEA were manually recorded, including their exact geographic 

coordinates and key attributes—particularly the stop type according to duration 

(short or long). 

Once both data sources have been collected and prepared, they are imported into QGIS. By 

integrating them, it becomes possible to visualize in a single map the strategic locations 

identified by Fraunhofer alongside the actual stop points identified by ACEA. 

This spatial analysis will enable us to identify which locations are common to both studies, 

thereby ensuring that the planning process is informed not only by theoretical models but 

also by actual usage patterns. This insight will be crucial in selecting the appropriate type of 

chargers, whether high-power MCS chargers or conventional ones, to be installed at each 

site. 

By applying this methodology, the aim is to achieve a more accurate and realistic planning 

approach, ensuring that the proposed charging stations effectively meet the future demand 

of electric trucks on European roads. 
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Chapter 3.  METHODOLOGY 

This chapter describes the methodological process followed to design and optimize a 

network of electric charging stations for long-haul trucks in the Spanish Mediterranean 

Corridor. The approach integrates spatial data analysis, demand modeling, and technical 

sizing in a sequential and structured manner. 

The process begins with the acquisition and preparation of data from two key sources: the 

Fraunhofer ISI (2024), which provides projections of truck traffic flows for 2030 across the 

European network, and the ACEA dataset, which maps the current distribution of truck rest 

areas. These inputs are used to identify high-relevance areas along the corridor. 

Next, a spatial analysis is carried out using QGIS to determine 18 candidate locations based 

on logistical importance, accessibility, and alignment with the TEN-T core freight routes. 

Once selected, a gravitational model is applied to evaluate the relative attractiveness of each 

point, incorporating both projected demand and geographic accessibility, while penalizing 

excessive proximity between stations through a corrective term. This optimization process 

yields the 12 most suitable locations for initial infrastructure deployment. 

Subsequently, the technical sizing of each station is performed based on expected truck flow 

and the probability of stopping. Fast chargers are dimensioned using M/M/s queueing theory 

to ensure short waiting times and efficient service, while slow chargers are sized using a 

static occupancy model focused on overnight or long-duration rest stops. 

Finally, the total cost of infrastructure deployment is estimated by multiplying the number 

of chargers per station by the corresponding unit costs. This step allows for an evaluation of 

economic feasibility and supports phased implementation planning. 

This methodology ensures that the resulting network is strategically located, technically 

feasible, demand-driven, and aligned with the European Union’s regulatory framework for 

alternative fuel infrastructure. 
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3.1 DATA ACQUISITION 

To determine the optimal locations for trucks electric charging stations, the process begins 

with a large pool of potential sites. For this purpose, two key studies are used as reference 

points: 

3.1.1 OPTIMIZED DEMAND-BASED CHARGING NETWORKS FOR LONG-HAUL 

TRUCKING IN EUROPE (FRAUNHOFER ISI, 2024) 

Published in 2024 by a team from the Fraunhofer Institute for Systems and Innovation 

Research (ISI) in collaboration with other researchers, this study presents a detailed 

framework for optimally locating high-power charging stations for long-haul electric trucks 

across Europe. 

The study aims to identify optimal locations for installing truck charging points in Europe 

and, simultaneously, to define the minimum number of stations needed to cover the 

maximum percentage of long-haul routes. The analysis incorporates: 

1. Traffic data (OD pairs): origins and destinations for freight transport across Europe. 

2. Charging station candidates: thousands of potential locations (service areas, truck 

stops, etc.). 

3. Capacity constraints: Each station has a limit on the number of trucks it can serve 

annually. 

4. Travel parameters: truck autonomy, maximum driving times (linked to rest 

regulations), and recharging. 

The study begins with over 50,000 truck stops across Europe, compiled from various sources 

including public databases and service area registries. Several filtering steps are then applied: 

• Removal of duplicates and locations that are excessively close to each other (less 

than ~9 km). 

• Prioritization of areas with higher potential (e.g., large service areas, stops with high 

truck traffic, or those near high-traffic corridors). 

Following this filtering process, the number of locations is reduced to approximately 10,000. 

In the subsequent optimization phase, factors such as traffic density, accessibility, and the 
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potential capacity of each site are analyzed. The algorithm then clusters and refines the 

results, generating a final set of 2,700 locations of strategic interest. 

This means that, across various demand and coverage scenarios, these locations consistently 

emerge as ideal points for deploying charging infrastructure. However, it is important to note 

that this does not imply that charging stations must be installed at all of these locations; 

rather, they represent an expanded catalogue of options to be assessed based on specific 

needs and available resources. 

From this strategic selection, the study processes approximately 1.5 million freight flows 

(OD pairs) across Europe, with projections extending to the year 2030. Only long-distance 

routes—defined as those exceeding approximately 335 kilometers—are considered in the 

analysis. 

In this context, it is assumed that each station can serve up to 100,000 trucks per year. If the 

traffic volume on a route exceeds this capacity, additional stations must be added or 

alternative locations must be considered. 

To determine the optimal placement of stations, the study employs an algorithm that, given 

a fixed “budget” of stations (e.g., 500, 1,000, etc.), selects their locations to maximize the 

coverage of electric truck traffic. This algorithm complies with several constraints: a 

maximum distance between stops based on EU driving and rest regulations (e.g., every 4.5 

hours), a minimal route deviation (trucks cannot deviate more than 5% or add more than 30 

minutes to their journey), and a capacity limit per station (no more trucks can be assigned 

than the station can handle annually). 

Key findings show that with approximately 500 stations, it is possible to cover around 50% 

of all long-haul electric truck traffic, assuming 15% of the fleet is electrified. With 1,000 

stations, coverage increases to 91% of long-distance traffic and approximately 75% of OD 

routes. Achieving coverage beyond 90% requires a substantial increase in the number of 

stations, particularly to serve lower-traffic routes or geographically challenging areas. The 

greater the capacity assigned to each station (e.g., 150,000 trucks/year instead of 100,000), 

the higher the coverage with the same number of locations. However, there are diminishing 
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returns: increasing station capacity from 10,000 to 100,000 trucks brings substantial 

improvement, while increasing it further to 150,000 yields only marginal additional benefits. 

The analysis also revealed several relevant insights. The algorithm tends to concentrate 

stations along the most heavily trafficked highways—such as the TEN-T network—

demonstrating a natural clustering around major corridors. Additionally, assuming longer 

truck ranges (700 to 900 km) and high-power charging (650 to 1,000 kW) significantly 

reduces the number of required stations. In contrast, shorter ranges or lower charging power 

necessitate more charging points to meet the same demand. 

Due to the vast number of OD routes, a random sampling system is used to manage the data 

volume efficiently. The study confirmed that even with samples representing just 1% of total 

routes, the results are consistent and can be extrapolated to the entire network. 

Lastly, certain exceptions and limitations must be acknowledged. Areas with low traffic 

density or adverse geographical conditions may be excluded from the model or require 

tailored planning strategies. Moreover, this phase of the study does not take into account the 

actual electrical grid availability at each location—that is, whether the required megawatt-

level power supply can realistically be installed. 

The study demonstrates that with a relatively moderate number of high-power charging 

stations, a significant portion of long-haul electric truck traffic in Europe can be 

accommodated. The findings highlight the importance of focusing on high-traffic corridors 

and deploying high-capacity stations to effectively meet future demand. 

Nevertheless, identifying 2,700 potential strategic locations does not imply that all of them 

should be developed into charging stations. These locations are presented as a broad set of 

options, offering flexibility in the design of charging networks. The final decision on how 

many stations to build, and where, depends on additional factors such as actual demand 

evolution, available investment, and the energy planning strategy of each region. 
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3.1.2 INTERACTIVE MAPS: ELECTRIC TRUCKS STOP LOCATIONS IN SOUTHERN 

EUROPE (ACEA, 2025) 

The interactive map published by the European Automobile Manufacturers’ Association 

(ACEA)—Electric Trucks Stop Locations in Southern Europe—provides a georeferenced 

inventory of service areas frequently used by heavy-duty vehicles in Spain, Portugal, Italy, 

and Greece. Each record includes the exact location of the stop and the average duration of 

stay: less than one hour (regulatory driving break) or more than eight hours (daily rest or 

overnight stop). 

This dataset is particularly valuable for two reasons. First, it confirms the corridors with the 

highest density of heavy traffic—most notably in Spain, the AP-7/A-7 corridor and access 

routes to major Mediterranean ports. This observation reinforces the initial selection of 

locations along the TEN-T network. Second, the distinction between short and long stops 

allows for a qualitative estimation of the power levels that future infrastructure may require: 

high-power charging for short driving breaks versus moderate-power charging for overnight 

stays. 

It is important to note, however, that the ACEA map does not provide information on the 

availability of electrical connections or on planned deployments of charging infrastructure. 

Therefore, in this study, it is used as a snapshot of current truck operations—and as an 

empirical complement—but the sizing of chargers is based exclusively on the hourly traffic 

profiles provided by MITMA’s permanent monitoring stations. 

3.1.3 COMPLEMENTING THE FRAUNHOFER STUDY AND ACEA RESOURCE 

The Fraunhofer ISI study and the interactive maps provided by ACEA offer a highly 

complementary approach, as each contributes essential elements for planning a charging 

network for electric trucks. ACEA provides an accurate depiction of current operational 

patterns, based on empirical data from the GPS tracking of approximately 400,000 trucks 

across Europe, accounting for around 750,000 stops aggregated into more than 30,000 

distinct locations. Of this total, the top 50% of locations concentrate nearly 50% of all 

recorded stops, enabling the precise identification of the most relevant stopping points. This 
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analysis is critical for prioritizing charging infrastructure in locations with established 

operational use, and ACEA recommends that these sites be equipped with MCS chargers by 

2027. 

On the other hand, the Fraunhofer ISI study also relies on real-world data—including the 

same GPS clusters recorded by ACEA—but enriches it with public station data and GIS 

criteria, resulting in a total of 10,624 candidate points. These locations are then processed 

through the CHALET model, which incorporates projected freight flows to 2030 in order to 

define an efficient network of up to 1,000 high-power MCS charging stations capable of 

covering 91% of long-distance transport demand. The goal of the Fraunhofer study is not to 

describe current stopping behavior, but to design an optimal infrastructure for the future 

electric fleet. 

The complementarity between the two approaches is strategically articulated across three 

dimensions: 

• Empirical validation: ACEA identifies where truck stops actually occur most 

frequently, while Fraunhofer proposes an optimized network. The overlap between 

the two datasets enables a consistency check of the model by highlighting both well-

established nodes and underutilized sites with high future potential. 

• Deployment prioritization: In the strategic proposal, priority is given to the charging 

sites identified by Fraunhofer as optimal that fall within a 5 km radius of any ACEA 

top-50% location. This proximity criterion ensures that selected sites are not only 

theoretically optimal but also demonstrate significant real-world usage. Moreover, a 

5 km radius is logistically appropriate, as it minimizes route deviations and aligns 

well with the spatial resolution of both data sources. 

• Energy needs coverage: By combining both studies, it becomes possible to determine 

not only the optimal locations but also the appropriate infrastructure sizing based on 

actual truck stopping patterns. This is essential for adapting deployment plans to the 

concrete demands of freight operations. 
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In conclusion, while Fraunhofer ISI provides a forward-looking optimized network based on 

real data and future projections, ACEA contributes a layer of current operational reality. 

Integrating both, through the application of a 5 km proximity filter between the optimized 

network and the top 50% of real-world stops, allows for the development of a deployment 

strategy that balances technical efficiency with operational feasibility. 

3.2 SPATIAL ANALYSIS USING QGIS 

To perform the spatial analysis required for selecting candidate locations, a QGIS project 

was created specifically for this study. The main objective of this phase was to integrate and 

visualize the relevant datasets in a geospatial environment in order to identify high-potential 

areas along the Mediterranean Corridor. The procedure began with the creation of a new 

QGIS project 

3.2.1 CREATE PROJECT IN QGIS 

The procedure begins with the creation of a new QGIS project and the configuration of the 

coordinate reference system to ensure compatibility with international datasets. As a visual 

aid, the Bing Maps base layer is added to the project. This map provides high-resolution 

satellite imagery and road information, which proved particularly helpful for contextualizing 

the locations of truck parking areas (from ACEA) and freight flow lines (from Fraunhofer), 

especially in less urbanized zones. In order to achieve all of this, the next steps must be 

followed. 

Step 1: 

Open QGIS (version 3.42.1). Create a new project from the top menu by clicking: 

Project → New 
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Figure 6.  QGIS Main Menu 

Step 2: Add Bing Basemap 

To insert a Bing basemap using the plugin manager, follow these steps: 

• Go to the top tab Plugins → Manage and Install Plugins 

• In the pop-up window, search for QuickMapServices and click Install Plugin (if it is 

not already installed) 

 

Figure 7. Installing QuickMapServices 
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• Once installed, go to the top menu Web → QuickMapServices → Bing → Bing 

Aerial (or select your preferred Bing map option) 

• Upon selection, the Bing basemap will automatically be added to the QGIS project, 

providing a clear geographic reference for importing and visualizing project data 

 

 

Figure 8. Adding Bing Map to QGIS 

 

When adding the Bing basemap through QuickMapServices, it is common for it to load using 

a different Coordinate Reference System (CRS)—typically EPSG:3857. An EPSG code 

identifies the coordinate system used to accurately place geospatial data on the map. 

To ensure all data layers align properly with this basemap, QGIS will automatically reproject 

any subsequently imported layers, if you correctly specify their original CRS (in this case, 

EPSG:3035 for the CSV files). Therefore, no manual adjustment is needed, just make sure 

to select the appropriate CRS during the import process for each dataset. 

When adding the Bing basemap via QuickMapServices, it typically loads using a different 

Coordinate Reference System (CRS), most commonly EPSG:3857. An EPSG code identifies 

the coordinate system used to accurately position geospatial data on a map. 
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To ensure that all visualized data aligns correctly with the basemap, QGIS will automatically 

reproject any subsequently imported layers—as long as you specify their original CRS 

correctly during the import process. For the CSV files used in this project, the original CRS 

is EPSG:3035. 

Therefore, no additional adjustment is required. Simply make sure to select the appropriate 

CRS (EPSG:3035) when importing each dataset, and QGIS will handle the reprojection to 

match the basemap. 

3.2.2 IMPORT DATA INTO QGIS 

Step 1: 

The Fraunhofer dataset is provided in CSV format with geographic coordinates (longitude 

and latitude). To import it into QGIS: 

Click on Layer → Add layer → Add Delimited Text Layer. 

 

Figure 9. Adding a layer in QGIS 

Step 2: 

Configure Import Settings in the Pop-Up Window 
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• Click the button next to File Name and select the downloaded CSV file from the 

Fraunhofer study 

• Set the Geometry Definition to Point (XY coordinates) 

• Assign the coordinate fields correctly to the respective columns (typically named 

“longitude” and “latitude”) 

• Choose the Coordinate Reference System (CRS): usually EPSG:4326 – WGS 84 

• Finally, click Add to load the layer into the project 

Once imported, the strategic points from the Fraunhofer study will be displayed on top of 

the Bing basemap. 

 

Figure 10. Layer import settings 

 

3. Importing Data Collected from ACEA 

The import process is identical to that used for the Fraunhofer dataset. The only difference 

is that, in Step 2, you select the manually compiled CSV file containing the ACEA data. 

4. Combined Visualization and Preliminary Analysis 
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With both layers added to the Bing basemap, they can now be viewed simultaneously in 

QGIS. 

This allows for a visual inspection of which strategic locations identified by the Fraunhofer 

study overlap with current truck stop points gathered from ACEA. This comparison helps 

determine the type of charging infrastructure (power and number of chargers) needed at each 

location. 

To enhance readability and distinguish the datasets: 

• In the Layers Panel (on the left side), right-click on each layer 

• Select Properties → Symbology 

• Choose different symbols or colors based on the data source (Fraunhofer vs. ACEA)  

This visual distinction is key for effective spatial interpretation and informed decision-

making. 

 

Figure 11. Fraunhofer and Acea spots 

As shown in Figure 11. Fraunhofer and Acea spots, the Layers Panel located in the bottom-

left corner displays the active layers currently being visualized on the map: 
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Mapas Acea: This layer corresponds to the data obtained from the ACEA interactive 

resource. It includes only the locations within the Autonomous Communities of Catalonia, 

Valencia, and Murcia, as data collection was limited to these regions, which constitute the 

study area for this project. 

PostOptimizationModel: This layer contains the strategic points extracted from the 

Fraunhofer study. 

On the right-hand side, the Layer Properties Panel corresponding to the selected layer 

(PostOptimizationModel) is displayed. In this case, the visual style of the layer has been set 

to yellow, allowing it to stand out on the map. Previously, the ACEA data layer was 

configured with a red color to clearly differentiate both data sources on the map. 

This visual distinction facilitates direct spatial comparison between theoretical strategic 

locations (Fraunhofer) and actual truck stop usage patterns (ACEA), enhancing the clarity 

and utility of the analysis. 

3.2.3 CREATING A BUFFER 

All points from the Fraunhofer catalog represent real service areas or rest stations. However, 

the study selects them from a purely optimization-based perspective, taking into account 

factors such as route coverage, estimated vehicle range, and annual capacity. In contrast, the 

ACEA cartography adds a quantitative dimension: it indicates which areas are actively used 

by the diesel fleet and how frequently. The objective of the spatial cross-analysis is therefore 

not to discard non-existent locations, but rather to prioritize those where the strategic 

relevance identified by Fraunhofer converges with empirical evidence of use provided by 

ACEA. 

The analysis was carried out in QGIS 3.42 following the steps described below. First, both 

layers were reprojected to the ETRS89 / UTM Zone 30N coordinate system (EPSG 25830) 

in order to work with consistent metric units. Then, a circular buffer with a radius of five 

kilometers was created around each ACEA stop. This distance corresponds to a maximum 

deviation of approximately five minutes of driving on a high-capacity road. The Intersect 
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tool was subsequently used to determine which points from the Fraunhofer catalog fell 

within at least one of the ACEA buffers. The spatial cross-analysis made it possible to 

distinguish between two groups of locations. The first group consists of sites that have dual 

support: they are identified as optimal by the Fraunhofer model and are also located within 

five kilometers of a stop regularly used by the diesel fleet. The second group includes those 

points that are only supported by the theoretical Fraunhofer model, with no nearby stop 

recorded by ACEA. 

For the Spanish Mediterranean corridor, approximately one-third of the locations fall into 

the first group, which represents dual evidence of demand. While both groups are retained 

in the analysis, the locations with dual support are considered high priority when planning 

the deployment phase, as they combine strategic coverage with anticipated operational 

acceptance. This prioritization criterion aligns with the coverage logic of the Fraunhofer 

model while also increasing the likelihood of successful and timely commissioning. 

It is important to note that the five-kilometer buffer does not affect the calculations for power 

capacity or the number of chargers, which are determined based on the hourly traffic profiles 

provided by MITMA’s permanent monitoring stations. The Fraunhofer–ACEA spatial 

overlay serves exclusively as a prioritization filter to enhance operational robustness, 

without altering the electrical sizing developed in the following chapters. 

What follows is a step-by-step explanation of how to create the buffer in QGIS. 

Step 1: 

• In QGIS, go to the top menu: Vector→ Geoprocessing Tools→ Buffer. 

When configuring the buffer using the MapasAcea layer, it is common for the distance to 

appear in degrees—units associated with the EPSG:4326 coordinate reference system—

rather than in kilometers. This occurs because the original layer uses geographic coordinates 

(latitude and longitude), where degrees are the default unit of measurement, not metric units 

like kilometers. 
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Figure 12. Buffer settings in degrees 

Step 2: 

To generate the buffer correctly in kilometers, it is first necessary to reproject the original 

layer to a projected coordinate system that uses meters as its unit of measurement. This can 

be done as follows: 

• From the top menu, select: 

Vector → Data Management Tools → Reproject Layer. 

• In the pop-up window, configure the following options: 

o Input Layer: Select original layer (MapasAcea). 

o Target SRC: Choose a projected system, such as EPSG:3035 (suitable for the 

Iberian Peninsula). If the study area covers other regions, select a CRS 

appropriate for that area 

o Click on Execute. 
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Figure 13. Reproject layer settings 

The new layer will now appear in QGIS with the default name “Reprojected” and a randomly 

assigned color. To avoid confusion, it is advisable to rename this new layer to MapasAcea 

and delete the original one. Additionally, you should assign the same color to this new layer 

that was previously used, in order to maintain visual consistency. This updated layer now 

uses metric units, making it suitable for buffer generation. 

Step 3: 

Repeat the buffer creation process using the newly reprojected layer:: 

• Top Menú: Vector → Geoprocessing Tools → Buffer. 

• In the pop-up window, configure the following settings: 

o Input Layer: "MapasAcea". 
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o Distance: Select 5 kilómetres. 

o Click on Execute. 

 

Figure 14. Buffer settings in kilometers 

The newly generated layer correctly represents a 5-kilometer area of influence around each 

point. 
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Figure 15. Visual representation of the buffers generated 

3.2.4 INTERSECTION TO IDENTIFY SUITABLE LOCATIONS FOR SIZING 

Once the 5-kilometer buffer has been generated around the ACEA points, the next step is to 

identify which of the strategic locations from the Fraunhofer study fall within this area of 

influence. 

For the intersection analysis to be valid, the Fraunhofer layer must be in the same Coordinate 

Reference System (CRS) as the buffer layer—for example, EPSG:25830. Therefore, the 

Fraunhofer layer must also be reprojected using the same method as before. 

Paso 1: 

• Top Menu: Vector → Data Management → Reproject Layer. 

o Input Layer: Select Fraunhofer Layer ("PostOptimizationModel"). 

o SRC objetivo: EPSG:25830. 

o Save the new Layer. 

o Click on Execute. 



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

36 

 

Figure 16. Reproject layer settings 

The new layer will now be named “Reprojected” by QGIS and assigned a random color. To 

avoid confusion, rename this layer to PostOptimizationModel and delete the original one. 

You should also apply the same color that was previously assigned to maintain visual 

consistency. This updated layer now uses metric units (meters) and is fully compatible for 

geoprocessing operations such as intersection. 

Step 2: 

• Top Menu and select: Vector → Geoprocessing Tools→ Cut. 

Step 3: 

• In the pop-up window, configure the following settings: 
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o Input layer: select the reprojected Fraunhofer layer 

("PostOptimizationModel") 

o Overlay layer: select the buffer layer ("Buffer_MapasAcea") 

o Output file: specify a file path and name for the resulting layer (e.g., 

"Fraunhofer_within_Buffer.shp") 

o Click on Execute. 

 

Figure 17. Cut settings 

The result will be a new layer containing only the points from the Fraunhofer study that fall 

within the 5-kilometer radius around ACEA stops. These points will be the only ones used 

in the subsequent sizing of electric truck charging stations. 

The following three figures illustrate the spatial analysis process carried out in QGIS to 

identify the strategic points from the Fraunhofer study that fall within the 5-kilometer area 
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of influence surrounding current diesel truck stop locations, as indicated by the ACEA 

interactive map. 

 

Figure 18. Zoom in of Acea spots and buffers 

 

In Figure 18. Zoom in of Acea spots and buffers, the layer corresponding to the ACEA points 

is shown in red, along with the 5-kilometer-radius buffers generated around each of them, 

represented as purple circles. These buffers define the area within which it is assumed that 

diesel and electric trucks could exhibit similar stopping behavior in terms of stop type. 
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Figure 19. Zoom in of Acea spots, Fraunhofer spots and buffers 

 

In Figure 19. Zoom in of Acea spots, Fraunhofer spots and buffers, the strategic locations 

from the Fraunhofer study have been added and are shown in yellow. It can be observed that 

some of these points fall within the buffers generated around the ACEA locations, with some 

even coinciding exactly. These points will be the only ones considered in the subsequent 

analysis, as their presence within the area of influence suggests that electric trucks are likely 

to stop in a manner similar to current diesel truck behavior according to ACEA data. 



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

40 

 

Figure 20. Zoom in of Fraunhofer spots within ACEA area 

Finally, Figure 20. Zoom in of Fraunhofer spots within ACEA area shows the result after 

applying the Clip tool in QGIS. Only the Fraunhofer study points that fall within the ACEA 

buffers remain—that is, the locations for which precise infrastructure sizing is possible, 

based on the predominant stop type observed at each site. 

This analysis allows for refining the initial set of locations proposed by Fraunhofer, focusing 

exclusively on those backed by real-world truck behavior data. In doing so, it ensures greater 

accuracy when planning what type of chargers to install (fast or slow) and how many, 

according to the expected usage at each site. 

 

3.2.5 ADDING TRUCK FLOW DATA 

A large number of potential locations have been identified for the installation of electric 

truck charging stations. However, this abundance poses a challenge in terms of optimization 
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and efficiency. Since charging demand is not uniformly distributed along the TEN-T 

network, it is necessary to filter these locations to focus on the most strategic ones. Those 

will provide the best access and service to electric trucks. 

To perform this selection, there will be taken into account two key factors: the distance of 

each location to the TEN-T network and the truck flow in the road segments closest to those 

locations. 

Truck flow data reveals the areas of highest traffic density along the TEN-T network, 

allowing us to identify the routes with the greatest demand for charging infrastructure. 

Meanwhile, proximity to the TEN-T network ensures that charging stations are located at 

easily accessible points for trucks, minimizing detours and charging-related downtime. By 

combining both factors, it can be determined the most cost-effective and efficient locations 

for installing charging stations. 

The article “Synthetic European Road Freight Transport Flow Data” (Fraunhofer ISI, 2022) 

provides a detailed analysis of heavy truck flows in Europe, including estimates of truck 

traffic on the TEN-T network. This dataset is essential for understanding freight flows and 

truck movement across major European transport corridors. 

The article is based on official transport data sources, such as the ETISplus project (European 

commission, 2013) and Eurostat (Eurostat, 2025), which are used to update model road 

freight flows across Europe. In the ETISplus study, growth factors are applied internally to 

adjust traffic volumes to 2019 levels and to project them forward to 2030. These adjusted 

flows are then assigned to minimum-cost routes on the European road network using 

Dijkstra’s algorithm, resulting in a synthetic dataset of truck traffic. 

The purpose of this dataset is to provide an accurate and representative view of truck flows 

between Europe’s major cities and logistics hubs. This helps identify high-traffic areas and, 

consequently, those most in need of charging infrastructure such as electric truck charging 

stations. 



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

42 

It will be use the truck flow data from the “Synthetic European Road Freight Transport Flow 

Data (January 2022)” along with four Excel files containing key information on the TEN-T 

network and the candidate locations for charging stations. These files provide the following 

data: 

• 04_network-edges.csv: Contains information about the segments of the TEN-T 

network, including the ID of each segment, start and end coordinates, and the length 

of each road segment. This file is essential for calculating the distance between 

charging stations and segments of the TEN-T network. 

• 03_network-nodes.csv: Provides the geographic coordinates of the TEN-T network 

nodes. Each node represents a connection point between segments, which is 

fundamental for defining the geometry of the network and calculating distances from 

charging stations to the TEN-T network. 

• 02_NUTS-3-Regions.csv: Contains data on NUTS-3 regions, which are 

administrative divisions in Europe. This file is used to organize and classify charging 

stations by region and facilitate spatial analysis of the locations. 

• 01_network-nodes.csv: Contains the coordinates of the proposed charging station 

locations. This file provides the geographic information necessary to represent and 

calculate the distance between charging stations and road segments on the TEN-T 

network. 

These files provide the essential data needed to calculate distances and truck flows 

accurately, thereby identifying the most suitable locations for charging station deployment. 

3.2.5.1 Loading the Data into QGIS 

The first step is to load the TEN-T network nodes, which contain the coordinates of the 

connection points between road segments. This is essential because the nodes define the start 

and end of each segment, enabling the calculation of distances from charging stations to the 

TEN-T network. 

• In QGIS, go to: Layer → Add Layer → Add delimited Text Layer 
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Figure 21. Adding a layer 

o Load 03_network-nodes.csv, which contains coordinates of the nodes. 

o In the import dialog window, assign the following fields: For X coordinate 

select the column Network_Node_X and for Y coordinate, select the column 

Network_Node_Y 

 

Figure 22. Layer import settings 

• Finally, set the CRS to EPSG:4326 (WGS 84), which is the standard geographic 

coordinate system. This ensures that the coordinates are interpreted correctly and that 
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the points are accurately placed on the map.Una vez cargados los nodos, se ven los 

puntos en el mapa, que representarán los lugares donde los tramos de carretera de la 

red TEN-T se conectan. 

Once the nodes have been loaded, they will appear as points on the map, representing the 

locations where the segments of the TEN-T road network connect. 

Next, it is needed to load the TEN-T road segments, which represent the actual stretches of 

road connecting the nodes. This file contains the segment IDs and the IDs of the start and 

end nodes, but does not include geographic coordinates. Therefore, it cannot be loaded 

directly as a geometry layer. 

• In QGIS, go to: Layer → Add Layer → Add Delimited Text Layer. 

 

Figure 23. Adding a layer 

o Load the file 04_network-edges.csv, which contains information about the 

road segments. 

o Since this file does not include geographic coordinates, it must be imported 

as a non-spatial table. Therefore, in the import dialog window, do not select 

any fields for the X or Y coordinates—this will ensure the file is loaded as a 

simple attribute table without geometry. 
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Figure 24. Layer import settings 

The table is containing the road segments, but it still lacks geometry—only the segment IDs 

and references to the start and end nodes of each TEN-T segment are available. 

3.2.5.2 Joining Attributes Between Nodes and Segments 

Next, it will use the “Join attributes by field value” tool to add the coordinates of the nodes 

to the segments table. This step is essential because it is needed for both the start and end 

coordinates of each segment in order to construct the line geometries of the TEN-T network. 

3.2.5.2.1  Join the Origin Nodes (Node A) 

• In QGIS, go to: View → Panels → Toolbox 

• On the right side of the screen, a toolbox panel will appear with various processing 

tools. The number and type of tools available can vary depending on the plugins 

you have installed. (Some tools may be different or additional if plugins are 

activated.)  
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Figure 25. QGIS' Toolbox 

• In the Processing Toolbox panel, search for the tool “Unir atributos por valor de 

campo” (Join attributes by field value). 
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Figure 26. Selecting Join attributes by field value (Unir atrributos por valor de campo) tool 

• Configure the parameters as follows: 

o Input Layer: 04_network-edges.csv (the TEN-T road segments table). 

o Join Layer: 03_network-nodes (the TEN-T nodes layer). 

o Field in Join Layer Network_Node_A_ID (the unique ID of each node). 

o Under Fields to add, select only Network_Node_X and Network_Node_Y 

to include the coordinates of the origin node for each segment. 
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Figure 27. Join attributes by field value (Unir atrributos por valor de campo) tool 

• Rename the resulting table as “Nodos A” for clarity. 

• Create two new columns named X_A and Y_A in this table. These fields will store 

the X and Y coordinates of the origin nodes. 

• To do this: Right-click on the “Nodos A” layer and select “Open Attribute Table”. 
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Figure 28. Opening attributes table 

Then, in the table, select the pencil icon at the top left, and then click on the "Add Field" 

icon. Use the same number type as the column or field being copied, in this case, decimal. 
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Here, it is chosen 10 decimal places for length and 10 for precision to ensure no information 

is lost. 

 

Figure 29. Adding field settings 

Then, as shown in Figure 29. Adding field settings, in the upper left section of the attribute 

table, select the target field X_A, and on the right side, choose the source field 

Network_Node_X. The X_A field has now been successfully created. Next, repeat the same 

process for the Y_A field. 
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Figure 30. Nodes A table 

The result is a new layer with the segments of the TEN-T network and the starting 

coordinates (X_A, Y_A) of each segment.  

3.2.5.2.2 Join Node B (Destination) 

Repeat the same process for the destination node of each segment: 

• Use the “Join attributes by field value” tool again. 

• Configure the parameters as follows: 

o Input layer: Nodos A (the layer containing the segments with the origin 

node coordinates) 

o Join layer: 03_network-nodes (the node layer) 

o Field in Input Layer: Network_Node_B_ID 

o Field in join layer: Network_Node_ID (the ID of each node) 

o Select the fields Network_Node_X and Network_Node_Y to obtain the 

coordinates of the destination node for each segment. 
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Figure 31. Join attributes by field value (Unir atrributos por valor de campo)  tool 

• The table is renamed to “Nodos”. 

• New columns named X_B and Y_B are created in the new table. These columns 

will contain the X and Y coordinates of the destination nodes. 
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Figure 32. Geometry table of TEN-T network 

This provides the complete geometry of the TEN-T network segments, with the starting 

coordinates (X_A, Y_A) and destination coordinates (X_B, Y_B). 

3.2.5.2.3 Create Lines Between Coordinates 

Once the start and end node coordinates of each segment are available, these can be used to 

create the lines that represent the road segments of the TEN-T network. 

To do this, a script must be written in Python using a text editor (e.g., Notepad). Then, the 

script will be executed in QGIS using the integrated Python console. When the script is run, 

it will automatically generate the line geometries—i.e., the roads—by connecting the start 

and end node coordinates for each segment. 

The script to generate the lines between origin and destination nodes is as follows. To run 

the Python script in QGIS, follow these steps: 

First, activate the Python Console. Then, you must give the command to execute the script 

file. This is done by entering the following command: 
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• exec(open(r"C:\Users\Juan\Documents\TFM\PythonFlujo.py").read())

 

Figure 33. Python console 

 

It is important to note that after open, you must enter the file path where the script is located, 

which will vary in each case. The example provided corresponds to the location and file 

name used in this case: “PythonFlujo”. 

• Press the Play button (Run Command) :A new layer called Flujo camiones is 

generated. To view it more clearly, you can temporarily deactivate the Bing Map 

layer. 

It can be observed that some lines cross over the sea to reach islands such as Corsica. This 

occurs because the dataset also accounts for trucks that travel by ferry, which are integrated 

into the model as part of the overall freight flow. 
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Figure 34. Visual representation of TEN-T network 

The content of the Python file can be found in this document at the appendix I. 

3.2.5.3 Distance from Potential Locations to the TEN-T Network 

Among the main advantages of measuring the distance to the TEN-T network is the 

optimization of accessibility, since the closer a charging station is to this network, the easier 

it will be for trucks to reach it without significant detours. It also leads to reduced travel 

time, minimizing the distance between charging stations and TEN-T road segments shortens 

waiting times and improves transport efficiency. Finally, it helps ensure coverage, since 

placing stations near the busiest segments guarantees access to charging points without 

requiring long diversions. 

The "Shortest line between objects" tool in QGIS is the most suitable option for calculating 

the minimum distance between charging stations and TEN-T road segments. It allows 

precise calculation of the shortest distance between a point (charging station) and a line 

segment (road section) in the network. 

This tool offers several advantages for the analysis. First, it provides accurate measurements, 

calculating the minimum distance between charging station locations and road segments, 

which results in more precise outputs than a simple straight-line distance. Additionally, it 
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helps optimize station placement by allowing visual identification and prioritization of 

stations closer to the TEN-T network, thus ensuring accessibility. Lastly, it enables efficient 

analysis by automating distance calculations, streamlining the decision-making process. 

In addition to distance, truck traffic flow is another key factor used to prioritize charging 

station locations. By integrating both data—distance to the TEN-T network and truck traffic 

flow—it is possible to identify the optimal locations to install charging stations along the 

most heavily used routes, ensuring higher demand and more efficient use of infrastructure. 

To use the "Shortest line between objects" tool, follow these steps:  

• Open the Processing Toolbox: 

o Go to Processing  → Toolbox in QGIS. 

• Search for the tool: 

o In the search bar, type "Shortest line between objects" (or in English: 

"Shortest path between objects"). 

o Select the tool 

• Configure the parameters: 

o Input Layer: Select the charging stations layer (e.g., 01_network-nodes.csv 

or the layer containing charging station locations). 

o Reference Layer: Select the TEN-T segments layer (e.g., 04_network-

edges.csv). 

o Join field of the input layer: If necessary, select the field representing the 

TEN-T node IDs. 
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Figure 35. Shortest line between objects tool 

• Run the tool. 

• Export the resulting layer, as it contains all the information about the generated 

lines. This includes the location of the charging station and the connected TEN-T 

segment. Additionally, a column named “distance” is created, indicating the length 

of the line — that is, the distance from the charging station to the TEN-T network. 

3.2.6 EXPORT INFORMATION 

When analyzing charging stations and the TEN-T network, the user encounters a large 

number of potential locations, making it necessary to conduct a selection process to identify 

the most suitable ones. 

The required layers are exported to analyze and select the 12 best charging station locations. 

These 12 sites are chosen because they are considered strategic for ensuring efficient 

coverage of the TEN-T network and greater accessibility for electric trucks. 

The "Shortest line between objects" tool in QGIS has been used to calculate the distance 

between each charging station and the nearest segment of the TEN-T network. By exporting 

this data, it is obtained essential information that enables us to efficiently choose the best 

locations. The exported layer includes: 
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• Charging station points: The geographic coordinates of the potential charging 

station locations. 

• The nearest flow segment to each station: Information about the closest TEN-T 

network segment to each station. 

• The distance from each station to the nearest segment: This metric is crucial to 

evaluate the accessibility of each station to the TEN-T network. 

The “Shortest line between objects” layer contains a large amount of additional information 

that is not relevant to this part of the study, such as the coordinates of the road segments or 

the presence of nearby hotels. The only required columns for selecting the 12 best charging 

station locations are: 

• QGIS-assigned code for each location, referred to as fyd by the software. 

• Coordinates of the potential charging station locations: Latitude and Longitude. 

• Information from ACEA-identified points within 5 km: Coordinates (Latitude and 

Longitude), type of stop, and stop frequency. 

• Truck flow in 2019 and projected for 2030 on the closest segment. This helps 

prioritize locations with higher charging infrastructure demand. 

• Distance between charging stations and the nearest TEN-T segment. 

3.3 SELECTION OF THE 12 BEST LOCATIONS 

To carry out the final selection of the 12 charging stations that will form part of the long-

distance electric truck charging network, a prioritization model based on the gravitational 

approach has been applied. This model, widely used in studies on optimal infrastructure 

placement, allows for the estimation of the attractiveness of each candidate point by 

considering both the heavy truck traffic flow in its surroundings and its distance to those 

flows. 

3.3.1 FOUNDATION OF THE GRAVITATIONAL MODEL 

The gravitational model is inspired by Newton’s law of gravity, according to which the 

attractive force between two bodies is proportional to their masses and inversely proportional 
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to the square of the distance between them. In the context of transport and location planning, 

this logic is translated as follows: 

To select the 12 most strategic charging stations within the long-distance electric truck 

charging network, a prioritization model based on the gravitational model has been applied. 

This approach, commonly used in territorial planning studies, estimates the attractiveness of 

a location as a function of the heavy vehicle traffic flow in its surroundings and the distance 

to the nearest traffic flow. 

The model is based on the following expression: 

𝐴𝑖̂ =
𝐹𝑗̂

𝑑𝑖𝑗
𝛽̂

+  𝜀
   (𝐸1) 

𝑨𝒊̂: Total attraction or score of charging 𝑖. 

𝑭𝒋̂: Normalized truck flow on segment 𝑗 . 

𝒅𝒊𝒋̂: Normalized distance between charging station 𝑖 and segment 𝑗. 

β: Distance penalization parameter, set in this study to 2. 

ε: Regularization constant, in this case 𝜀=0,01 which prevents division by values 

close to zero. 

3.3.2 NORMALIZATION OF VARIABLES 

Both truck flow, 𝐹𝑗, and distance, 𝑑𝑖𝑗, were normalized before being used in the model in 

order to: 

• Ensure that both variables are on the same numerical scale. 

• Prevent one variable from artificially dominating the other. 

• Facilitate the relative interpretation of the results. 

Min-max normalization was applied, defined by the following expressions:  
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𝐹𝑗̂ =
𝐹𝑗 − 𝐹𝑚𝑖𝑛

𝐹𝑚𝑎𝑥 − 𝐹𝑚𝑖𝑛
 𝑦  𝑑𝑖𝑗̂ =

𝑑𝑗 − 𝑑𝑚𝑖𝑛

𝑑𝑚𝑎𝑥 − 𝑑𝑚𝑖𝑛
  (𝐸2 𝑦 𝐸3) 

𝐹𝑚𝑎𝑥 and 𝐹𝑚𝑖𝑛 are the maximum and minimum truck flow values among the considered 

segments. 

𝑑𝑚𝑎𝑥 y 𝑑𝑚𝑖𝑛 are the maximum and minimum observed distances between charging stations 

and road segments. 

3.3.3 PROXIMITY PENALTY FOR CHARGING STATIONS 

The gravitational model assigns each location a base score that reflects, on one hand, the 

intensity of truck traffic passing through the nearest TEN-T segment and, on the other, the 

exact distance between the charging station and that segment (the shorter the distance, the 

greater the accessibility, and therefore the higher the score). However, it may happen that 

two locations with very high scores are so close to each other that, in practice, they end up 

capturing the same potential demand: trucks stopping at one will barely travel a few hundred 

meters to refuel at the other. To avoid this redundancy — that is, multiple charging stations 

“eating” the same market — it is introduced a proximity penalty that reduces the value of 

the combination when two selected stations are too close; this penalty increases rapidly as 

the distance between them decreases, discouraging concentration and favoring a more 

balanced territorial coverage. 

The model starts with a set of 18 candidate locations identified for their individual 

attractiveness; the final goal is to select exactly 12 of them to form the initial charging 

network. To make the decision, a spreadsheet was programmed in Excel with a VBA module 

that exhaustively generates the 48,620 possible combinations. In each iteration, the 

algorithm (i) adds the base score of the 12 charging stations involved — a value that depends, 

as indicated, on the truck flow on the adjacent TEN-T segment and the actual access distance 

— and (ii) calculates, one by one, the penalty terms linking each charging station to the other 

eleven in the same combination. The penalty accumulated for a specific pair increases 

rapidly as the separation between the two points decreases, reflecting the loss of efficiency 

in placing two stations very close to each other and “competing” for the same demand. In 
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this way, the algorithm assigns each combination a final score that results from subtracting 

all the internal penalties from the aggregated benefits, and selects, as optimal, the 

combination of 12 locations whose final value is the highest. 

Each charging station 𝑖 receives a penalty based on how close it is to the other selected 

stations. Specifically, its penalty is defined as: 

𝑝𝑒𝑛𝑖 = 𝜆 𝑥 
1

∑ 𝑑𝑖𝑗
2𝑗∈𝑠

𝑗≠𝑖

 (𝐸4) 

where the denominator is the sum of the squared distances between the charging station i 

and the other eleven j in the combination S. The interpretation is that if i has very close 

neighbors (small distances), the sum becomes low, and the fraction — therefore the penalty 

— increases significantly. However, if it is reasonably far apart, the sum grows, and the 

penalty is diluted. 

λ is the coefficient that balances between maximizing captured demand and minimizing 

spatial redundancy, so it directly influences the final network selected. This coefficient is 

recalculated for each iteration, adapting automatically to the average quality (mean score) of 

the 12 charging stations being evaluated at that moment. 

The coefficient is calculated as: 

𝜆 =  𝑓 𝑥 
∑ 𝐴𝑖̂𝑖∈𝑠

12
 𝑥 𝑅2 (𝐸5) 

𝑓: Coverage factor (from 0 to 1) that controls the strength of the penalty. 

∑ 𝐴𝑖𝑖∈𝑠

12
: Average score of the 12 charging stations in combination S. 

𝑅: Radius of influence, the distance at which two stations begin to overlap. 

In summary, the formula for λ takes the average score of the 12 stations in the current 

iteration and scales it by the square of the radius of influence. Thus, it is setted a coverage 

factor 𝑓=1 and an influence radius 𝑅=10 km. 
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R=10 km, the model indicates that when two stations are exactly 10 km apart, the penalty 

applied to each equals their average score — effectively nullifying the utility of that station 

due to overlap. This reflects a decision to fully penalize redundancy at that distance. 

Aggregate penalty of the combination is obtained by summing the twelve individual 

penalties: 

𝑃𝐸𝑁 = ∑ 𝑝𝑒𝑛𝑖

𝑖∈𝑠

 (𝐸6) 

Ultimately, the score of each iteration is calculated using the following expression, and the 

selected combination is the one that yields the highest value of Z. 

𝑍 = ∑ 𝐴𝑖̂

𝑖∈𝑠

− 𝑃𝐸𝑁 (𝐸7) 

To avoid a manual calculation, which is impractical with 48,620 combinations, a VBA 

macro was implemented in Excel. The script is provided in Appendix I. This macro generates 

all possible combinations of 12 charging stations, recalculates λ in each iteration, computes 

the benefit and penalty, and retains only the list with the highest Z.  

3.3.4 THE BEST 12 LOCATIONS 

Once the attractiveness index for each of the candidate locations was calculated, they were 

sorted in descending order based on the value obtained. This ranking reflects the relative 

capacity of each charging station to attract charging demand, simultaneously considering the 

projected traffic intensity for 2030 and geographical accessibility. 

Based on this ranking, the 12 locations with the highest gravitational scores were selected to 

form the priority network of charging stations for electric trucks. These locations represent 

the best strategic options, as they maximize long-distance freight coverage with a limited 

number of installations. The 12 points where the charging stations will be placed can be seen 

in  
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Figure 36. Final 12 locations for truck electric chargers 

 

3.3.5 GRAVITACIONAL MODEL RESULTS 

The application of the gravitational model has made it possible to identify the 12 optimal 

locations for deploying high-capacity charging stations aimed at heavy-duty traffic by 2030. 

As shown in the Figure 36, most of the selected locations are concentrated along the 

Mediterranean coastal corridor, connecting major logistics and urban hubs from the region 

of Murcia to the French border. 

This pattern directly reflects the model’s results, which integrated both the projected truck 

flow intensity and the geographic accessibility of each point. The selected charging stations 

tend to be located: 

• In proximity to major interchange hubs (València, Barcelona). 

• Near key logistics borders (La Jonquera, Port of Cartagena). 

• Along the TEN-T network and the EU's priority transport corridors. 
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It is also worth highlighting the inclusion of strategic intermediate locations that ensure 

homogeneous coverage over long stretches. These allow compliance with electric truck 

range limitations and promote the operational continuity of long-distance freight transport. 

3.4 ELECTRIC CHARGERS 

Following the identification of the 12 optimal locations for the implementation of electric 

truck charging stations, the next step is to determine the necessary capacity at each site—

specifically, the number and type of chargers required to adequately serve the expected 

volume of electric trucks. 

Two types of chargers are distinguished: 

• Fast chargers (MCS), designed for on-the-go charging during working hours. 

• Slow chargers, intended for overnight or prolonged charging, typically at rest 

areas or logistics centers. 

3.4.1 CHARGERS TYPES 

To efficiently and cost-effectively meet charging needs, the selected model is the Power 

Electronics MCS 1440 kW charger, with a cost of €394,000 per unit. Already deployed in 

Spain, this charger offers a key operational advantage: it includes four outputs and can 

function either as a single ultra-fast charger or as multiple lower-power chargers, thanks to 

its dynamic power distribution capability. 

At each location, a number of these chargers will be installed equivalent to the number of 

fast chargers previously calculated. During the day, each unit will operate as a single 

1440 kW ultra-fast charger, aimed at satisfying in-transit charging demand. At night, these 

same units will switch to multi-outlet mode, enabling up to four trucks to be charged 

simultaneously. 

Power distribution is not fixed; instead, it dynamically adjusts based on the specific demand 

of each connected vehicle. For example, if several trucks are connected, the system can 
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allocate the total available power across the outputs depending on each vehicle’s needs, 

ensuring flexible and efficient use of capacity. This operational flexibility allows the 

infrastructure to adapt to different scenarios without compromising performance or requiring 

oversizing. 

This solution optimizes infrastructure use by avoiding the need to duplicate equipment for 

different time slots, representing a significant reduction in both installation and operational 

costs. 

In cases where projected overnight charging demand exceeds the capacity of the installed 

MCS units (i.e., if more slow chargers are needed than the available MCS outlets can 

provide), additional 100 kW chargers, such as the Hypercharger HYC200, will be installed 

at a cost of €50,820 per unit. These units are more affordable and suitable for prolonged 

overnight charging, effectively meeting the needs of trucks during rest periods. 

3.4.2 SIZING OF FAST CHARGERS USING QUEUEING THEORY  

The dimensioning of fast chargers will be carried out using an M/M/s queueing model, 

widely employed in infrastructure planning where there is stochastic (random) demand and 

variable service times. To apply the model, two key parameters need to be known: the 

average charging time of an electric truck on this type of charger and the number of trucks 

requiring recharging at each station per hour. To properly determine the necessary number 

of chargers at each of the charging stations, queueing theory will be used, specifically the 

M/M/s model. This method is particularly suitable for this task due to the random nature of 

both the arrival of trucks at the station and the time needed to charge each truck. 

The M/M/s model is based on the following assumptions: 

• Truck arrivals follow a Poisson distribution, meaning trucks arrive independently 

and at random intervals. 

• Service time (charging time) follows an exponential distribution. This reflects the 

natural variability in charging durations—some trucks charge slightly faster, others 

slower. The exponential distribution is well-suited for representing such processes, 



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

66 

where time between events (in this case, full charges) is variable but statistically 

regular. 

• Multiple servers (chargers) are available (s servers), which aligns with the real-world 

scenario of having several charging points operating simultaneously at each station. 

The three key parameters in the model are: 

λ: The number of trucks arriving per hour at the station. This value has been 

calculated previously. 

µ: The number of charges a single charger can perform per hour, derived from the 

assumed average charging time per truck. 

S: The number of chargers available — this is the variable to be determined. 

3.4.2.1 Average charging time 

According to EU Regulation No. 561/2006, professional drivers are required to take a 

minimum 45-minute rest after a maximum of 4.5 hours of continuous driving. For long-haul 

trucks traveling at average highway speeds (around 75 km/h), this corresponds to 

approximately 335 km between mandatory stops. 

 

In line with this regulation, our study considers that electric trucks should ideally be able to 

drive up to 335 km before requiring a charge. Covering this distance is estimated to consume 

approximately 600 kWh, based on projected 2030 energy consumption rates for heavy-duty 

battery electric trucks. 

Assuming the use of 1.440 kW ultra-fast chargers, compliant with future MCS standards, 

the time required to charge 600 kWh is 25 minutes. 

25
𝑚𝑖𝑛

𝑐ℎ𝑎𝑟𝑔𝑒
= 0,412

ℎ

𝑐ℎ𝑎𝑟𝑔𝑒
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μ =
1

0,4167
= 2.4 

𝑐ℎ𝑎𝑟𝑔𝑒𝑠

ℎ𝑜𝑟𝑎
 (𝐸8) 

This value will be used as the service rate in the M/M/s model. 

3.4.2.2 Demand Calculation 

To accurately size the number of chargers at each of the 12 selected charging stations, it is 

necessary to estimate the number of trucks per hour under a representative high-demand 

scenario. However, the available data from the file "Traffic Flow Trucks 2030" only provides 

the total annual truck flow. Therefore, a rigorous procedure is needed to estimate the daily 

and subsequently the hourly flow realistically. 

The method followed consists of several clearly defined stages: 

3.4.2.2.1 Identification of nearby permanent stations 

First, the nearest permanent station from the Ministry of Transport, Mobility and Urban 

Agenda (MITMA) will be identified for each of the 12 selected charging locations. To do 

so, the official map viewer available at: https://mapatrafico.transportes.gob.es/2022/ 

(Ministerio de Transportes y Movilidad Sostenible, 2022) 

These permanent stations provide reliable data on the actual temporal distribution of heavy 

vehicle traffic throughout the year. 

3.4.2.2.2 Actual anual traffic distribution 

From the same official viewer of the Ministry of Transport, Mobility and Urban Agenda 

access is gained to the files associated with each permanent traffic counting station. By 

clicking on a station, a set of documents is displayed, including a PDF that breaks down the 

number of heavy vehicles by day of the week and month. 

Using this information, a complete 2022 calendar was recreated in Excel. For each of the 

365 days of the year, the following was identified: 

▪ The exact date (January 1, January 2, ..., December 31), 

https://mapatrafico.transportes.gob.es/2022/


UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

68 

▪ The corresponding day of the week (Monday, Tuesday, etc.), 

▪ The month to which it belongs. 

Next, each date was assigned the corresponding number of trucks based on its month and 

day of the week, using the values extracted from the PDF table of the selected station. 

This procedure enabled the construction of a daily database with realistic estimates of the 

number of heavy vehicles passing through the station on each day of 2022. 

3.4.2.3 Identification of the 100th Highest Demand Day 

Once the daily traffic assignment was completed, a time series of 365 values was obtained, 

representing the estimated number of trucks that circulated each day through the permanent 

station closest to each candidate charging location. 

Using this series, the daily traffic values were sorted from highest to lowest to identify the 

100th busiest day. This day is considered representative of a high—though not extreme—

demand scenario, and serves as a practical reference for the infrastructure sizing at each of 

the 12 selected charging locations. 

3.4.2.4 Projection of the Highest Demand Day to 2030 

The traffic flow identified for the 100th highest demand day corresponds to empirical data 

from 2022. However, in order to correctly size the charging stations for the 2030 horizon, 

this value must be projected to reflect future expectations aligned with the anticipated growth 

in freight transport by road. 

To do this, the projection developed by Fraunhofer ISI (2024) is used. This study estimates 

the evolution of heavy vehicle traffic on the European TEN-T network through 2030. It 

provides expected annual truck volumes on strategic routes, allowing the estimation of traffic 

increase compared to the base year. 

The approach consists of calculating the percentage that the 100th day represents in relation 

to the total annual volume recorded in 2022 for each permanent station. This daily proportion 
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(e.g., 3.1% of the annual total) is considered relatively stable under the assumption that 

temporal traffic patterns will remain largely unchanged over time. 

Once this percentage is determined, it is applied to the projected annual volume for 2030 

(according to Fraunhofer’s model). This yields an estimated number of heavy vehicles 

circulating on the 100th day of 2030, providing a reliable baseline for technical dimensioning 

of the charging infrastructure at each selected location. 

3.4.2.5 Estimated Share of Electric Trucks 

Before calculating hourly flow, an estimate is made of the percentage of trucks expected to 

be electric. In this study, it is assumed that 7% of heavy traffic will be electric by 2030. 

However, there are several studies on this topic, with some suggesting a 5%  and others 

pointing to 10%-11%. In this study, it has been used 7%, as it seems to be the most widely 

agreed-upon scenario. 

3.4.2.6 Estimation of Hourly Flow and Peak Hour Selection 

The official MITMA viewer provides, for each permanent traffic counting station, the hourly 

distribution of heavy vehicle traffic broken down by day of the week. This allows for a 

precise understanding of how truck traffic is distributed across 24 hours, distinguishing for 

example a Monday from a Friday or a Sunday. 

From this detailed station and day-specific distribution, the peak hour for the previously 

determined 100th highest demand day was identified. This hour represents the time of 

highest truck concentration, and is therefore the most demanding scenario from the 

perspective of station sizing on that day. 

The hourly value obtained will be used as a reference to calculate the number of fast chargers 

required at each location, thereby ensuring that the infrastructure can adequately serve the 

maximum expected demand. 

3.4.2.7 Calculating potential customers 

Therefore, to determine the number of trucks per hour that will pass through the road 

segment where the charging station is located, the following formula is used: 
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𝑡𝑟𝑢𝑐𝑘𝑠

ℎ𝑜𝑢𝑟
= 

= 𝐷𝑎𝑦 100 𝑤𝑖𝑡ℎ ℎ𝑖𝑔ℎ𝑒𝑠𝑡 𝑑𝑒𝑚𝑎𝑛𝑑 𝑖𝑛 2030 𝑥 % 𝐸𝑙𝑒𝑐𝑡𝑟𝑖𝑐 𝑇𝑟𝑢𝑐𝑘𝑠 𝑥 % 𝑃𝑒𝑎𝑘 ℎ𝑜𝑢𝑟𝑠 𝑡𝑟𝑢𝑐𝑘𝑠 (𝐸9) 

 

3.4.2.8 Stopping probability 

Now it must be obtained the estimated number of electric trucks that could stop at each 

charging station during the peak hour. However, not all of these trucks will actually stop; 

the actual stopping probability will depend on the distance to the next available charging 

station. 

It is initially assumed that the flow of electric trucks is evenly divided, with 50% heading in 

one direction and the other 50% in the opposite direction. To calculate how many trucks will 

stop in each direction, the following formula is applied to each direction: 

𝑃𝑟𝑜𝑝𝑜𝑟𝑡𝑖𝑜𝑛 𝑠𝑡𝑜𝑝 =  
 𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 𝑡𝑜 𝑡ℎ𝑒 𝑛𝑒𝑥𝑡 𝑒𝑙𝑒𝑐𝑡𝑟𝑖𝑐 𝑐ℎ𝑎𝑟𝑔𝑖𝑛𝑔 𝑠𝑡𝑎𝑡𝑖𝑜𝑛 𝑖𝑛  𝑑𝑖𝑟𝑒𝑐𝑡𝑖𝑜𝑛  "𝑥"

335
 (𝐸10) 

The choice of 335 km as a reference is based on the typical projected range for electric 

trucks, assuming that each truck will need to recharge at least once every 335 km. Therefore, 

if the distance to the next charging station is exactly 335 km, the stopping probability would 

be 100%. This means all trucks in that direction would stop at this charging station. For 

example, if the distance is 200 km, the stopping probability would be estimated at 60% (200 

km / 335 km). This approach allows for precise dimensioning, tailored to the specific 

characteristics of the projected charging network. 

Once the flow of electric trucks per hour is obtained, it is assumed that half of the total flow 

travels in each direction. Then, the flow in each direction is weighted by the previously 

calculated stopping proportion, resulting in a realistic number of electric trucks that will 

actually stop at each charging station. This approach allows for precise and tailored 

dimensioning based on the specific characteristics of the projected charging network. 



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

71 

3.4.2.9 Formulas of the M/M/S model based on the obtained parameters  

3.4.2.9.1 System Utilization Rate: 

р =
𝜆

𝑠 𝑥 µ
 (𝐸11) 

It represents the percentage of time the chargers are occupied. If it approaches 1, it means 

the system is heavily loaded, and queues will form. If it exceeds 1, the system is unstable, 

meaning more trucks are arriving than the chargers can handle. In this case, the queues would 

grow indefinitely, and the charging station would collapse operationally. 

3.4.2.9.2 Probability of a Truck Having to Wait: 

𝑃𝑞 =

(𝑠р)𝑠

𝑠! (1 − р)

∑
(𝑠р)𝑘

𝑘!
+

(𝑠р)𝑠

𝑠! (1 − р)
𝑠−1
𝑘=0

 (𝐸12) 

. 

The probability, 𝑃𝑞 ,  that a truck will have to wait when arriving, as all chargers are occupied, 

is given by Erlang-C's formula. 

3.4.2.9.3 Average Waiting Time in the Queue 

𝑊𝑞 =
𝑃𝑞

𝑠µ − 𝜆
 (𝐸13) 

This value indicates how much time, on average, a truck will wait before it can begin 

charging. The higher the utilization rate or the fewer the chargers, the higher this time will 

be. This metric is key to ensuring a good service level and avoiding logistical delays. 

3.4.2.9.4 Total Time in the System: 

𝑊𝑇 = 𝑊𝑞 +
1

µ
 (𝐸14) 
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This value represents the total time a truck spends from arrival to the end of the charging 

process. 

3.4.2.10 Fundamental design conditions: 

The total time in the system (waiting time plus charging time) should not exceed 50 minutes 

to guarantee an adequate level of service. 

The utilization rate (the proportion of time the chargers are occupied) should not exceed 0.95 

to avoid station saturation and to allow for operational margin. 

3.4.2.11 Calculation in Excel 

The parameter that is calculated in the context of the M/M/s queueing model is "s," which 

represents the number of servers (chargers) needed at each electric charging station. In this 

case, "s" is the number of chargers required to meet the specified design conditions. These 

conditions are a utilization rate below 95%, ensuring that the chargers are not overloaded, 

which would lead to long waiting times and decreased service efficiency. A high utilization 

rate could result in long queues and delays for the trucks. Additionally, the total time in the 

system must be below 50 minutes, which guarantees that the time a truck spends at the 

charging station, including both waiting time and charging time, does not exceed the 50-

minute limit. This condition is critical for maintaining operational efficiency. 

The process involves evaluating different values for "s" (the number of chargers) until both 

of these conditions are met. This iterative approach allows for the optimal number of 

chargers to be determined based on the expected traffic and the system's design constraints. 

Essentially, the goal is to find the "s" value that ensures the system can handle the expected 

demand without exceeding the capacity or causing excessive delays. 

3.4.3 SIZING OF SLOW CHARGERS 

Once the number of fast chargers required has been determined using the M/M/s queueing 

theory model, it is also necessary to calculate the number of slow chargers required at each 

charging station. These chargers are primarily intended to address needs other than 

immediate transit, mainly: 
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• Trucks that make prolonged stops, such as overnight rests or technical stops. 

• Vehicles that park for several hours and do not require immediate charging. 

For this case, queueing theory cannot be used, as the nature of the use of slow chargers is 

fundamentally different. Unlike fast chargers, where there is a continuous flow of arrivals 

and departures, in the case of slow chargers, vehicles remain parked for long periods, 

especially overnight, without significant turnover. 

Consequently, a static occupancy approach is adopted. This model assumes that: 

• The arrivals of trucks requiring slow charging are concentrated within a specific time 

interval during the day. 

• Each truck that stops for overnight rest occupies a charging point for the entire night. 

No queues or significant waiting times occur, as there is no rotation of use during this period. 

This behavior does not correspond to a dynamic service system but rather to a stationary and 

simultaneous usage pattern. Therefore, the sizing is based on estimating how many trucks 

regularly overnight at the station and ensuring an equivalent number of slow chargers, 

guaranteeing coverage without relying on rotations or service shifts. 

This approach allows for precise sizing of the nighttime charging capacity, adapting to the 

real needs of heavy transport during extended rest hours. 

To estimate how many slow chargers are needed at each charging station, the following 

procedure is followed: 

1. Start with the daily flow of electric trucks that will pass through the section of road 

where the charging station is located. 

2. From this daily flow, only 16.67% is considered, corresponding to trucks that will 

travel between 21:00 and 06:00, assuming these are the vehicles that have the 

potential to make an overnight stop. 

3. As with the fast chargers, it is assumed that the truck flow is evenly split between 

both directions (50% in each direction). 
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4. To estimate how many trucks will actually stop at the charging station, a stop 

proportion is calculated based on the distance to the next charging station in each 

direction, using the same logic as in the fast charger sizing. 

 

𝑃𝑟𝑜𝑝𝑜𝑟𝑡𝑖𝑜𝑛 𝑠𝑡𝑜𝑝 =  
 𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 𝑡𝑜 𝑡ℎ𝑒 𝑛𝑒𝑥𝑡 𝑒𝑙𝑒𝑐𝑡𝑟𝑖𝑐 𝑐ℎ𝑎𝑟𝑔𝑖𝑛𝑔 𝑠𝑡𝑎𝑡𝑖𝑜𝑛 𝑖𝑛  𝑑𝑖𝑟𝑒𝑐𝑡𝑖𝑜𝑛  "𝑥"

335
 (𝐸15) 

 

5. The estimated number of trucks stopping in each direction is added together. The 

result represents the total number of trucks that will overnight at the station, and 

therefore, the number of charging points needed. 

6. Finally, the number of fast chargers already sized for that location is subtracted 

from this total number, as these chargers could also be used by trucks during 

prolonged rest. The difference represents the number of additional slow chargers 

needed. 
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Chapter 4.  RESULTS ANALYSIS 

As a result of the application of the gravitational model, a total of 12 optimal sites have been 

selected for the installation of electric truck charging stations along the Spanish 

Mediterranean Corridor. The selection was based on a maximization of the attractiveness 

index, which was calculated considering the projected truck flow for 2030 and geographic 

accessibility, while simultaneously penalizing excessive proximity between stations using a 

corrective term in the objective function. The optimal solution corresponds to the set that 

maximizes demand coverage, avoids unnecessary overlap, and balances the infrastructure 

along the road axis. 

4.1 GEOGRAPHICAL DISTRIBUTION 

The selected charging stations are distributed along the main segments of the AP-7, A-2, A-

31, A-7, V-23, and C-17 roads, with a special concentration on the most critical points of the 

Mediterranean Corridor. This network spans from the Murcia region to the French border, 

passing through key logistics hubs such as Valencia, Tarragona, Barcelona, Castellón, and 

Girona. 

A balance has been achieved between stations near major urban centers and others located 

in intermediate segments to ensure the operational continuity of the vehicles. The average 

distance between stations is around 160 km, which ensures compatibility with the expected 

autonomy of electric trucks and compliance with the European regulations on rest periods. 

Code Province Road Exit Permanent station 

9 
 

AP-7 594 B-42-0 
7 

 
C-17 13 B-28-0 

3 
 

A-2 708 GI-20-0 
17 

 
AP-7 11 B-26-0 

1 
 

AP-7 3 GI-13-0 
29 

 
A-31 220 A-536-0 

13 
 

A-3 337 V-385-0 
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14 
 

A-2 517 L-200-0 
10 

 
A-7 1153 T-61-0 

11 
 

V-23 2 V-83-0 
2 

 
AP-7 42 CS-145-0 

24 
 

AP-7 45 CS-113-0 

Table 2. Geographical information  of the 12 electric charger station locations 

4.2 TECHNICAL SIZING OF CHARGERS 

At each of the 12 selected stations, the sizing of fast and slow chargers has been carried out 

based on the estimated hourly flow, the probability of a stop, and the distance to the next 

available station in both directions. The estimation of electric trucks in 2030 in this study 

has been 7%, as it is the scenario which most studies agree and therefore, the one with the 

highest probability to occur. Nevertheless, in section 4.6 a sensitivity analysis has been 

conducted in order to see how the penetration of electric trucks affect to the total cost. For 

fast chargers, the M/M/s queueing theory model has been applied, with the goal of ensuring 

a total station pass-through time of less than 50 minutes and a maximum utilization rate of 

95%. For slow chargers, aimed at overnight stops or prolonged rests, a static occupancy 

model has been adopted. 

The result is a differentiated allocation by station, with between 2 and 8 fast chargers and up 

to 4 slow chargers at locations with the highest nighttime presence. This differentiation helps 

to optimize resource use, avoid over-sizing, and adapt to the expected usage patterns. 

4.3 ECONOMIC COST OF THE INFRAESTRUCTURE 

Based on the number of chargers sized at each location and the unit installation costs 

(€50,820 per slow charger and €394,000 per fast charger), the total deployment cost has been 

estimated. These values are based on discussions with experts from the project team and 

reflect current market conditions and installation standards. The result is summarized in table 

3: 
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Electric charging 
station code 

Chargers (Units) Price (€) 

Slow Fast (MCS) Slow Fast (MCS) Total 

9 4 8 203.280 3.152.000 3.355.280 
7 0 4 0 1.576.000 1.576.000 
3 2 7 101.640 2.758.000 2.859.640 

17 0 6 0 2.364.000 2.364.000 
1 0 3 0 1.182.000 1.182.000 

29 0 7 0 2.758.000 2.758.000 
13 0 7 0 2.758.000 2.758.000 
14 0 3 0 1.182.000 1.182.000 
10 0 4 0 1.576.000 1.576.000 
11 0 2 0 788.000 788.000 

2 2 2 101.640 788.000 889.640 
24 0 2 0 788.000 788.000      

22.076.560 

Table 3.Breakdown of the total price per electric truck charging station 

The average cost per station is €1.83 million, and the average cost per charger (combining 

both types) is approximately €183,250. These figures confirm the economic viability of the 

proposed deployment plan, especially considering its capacity to cover most of the expected 

heavy electric transport flows for 2030. 

4.4 CRITICAL EVALUATION OF THE APPLIED MODEL 

The proposed prioritization model has proven effective in identifying optimal charging 

station locations based on projected demand, geographic accessibility, and spatial 

distribution. Unlike simplistic distance-based approaches, this method integrates empirical 

data (MITMA, ACEA), demand forecasts (Fraunhofer), and spatial optimization techniques 

to develop a realistic and operationally coherent network. 

One of the key strengths of the model lies in its balance between coverage and redundancy 

avoidance. By including a corrective term that penalizes excessive proximity between 

stations, the model avoids inefficient clustering and promotes territorial continuity. 
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Another relevant feature is its flexibility. The model can be updated as new data becomes 

available—such as real-world electric truck adoption rates, local energy grid constraints, or 

changes in traffic flows—without needing to restart the entire analysis. 

It is worth noting that while the model performs well under the assumptions used, future 

scenarios may introduce uncertainties. For example, a significant increase in demand at a 

specific station may challenge the queueing-based sizing, requiring dynamic adjustments or 

local reinforcements. Nonetheless, the modular and data-driven nature of the methodology 

makes it highly adaptable to future expansion phases or policy changes. 

4.5 ALIGNMENT WITH EUROPEAN REGULATIONS  

The AFIR regulation, adopted in 2023, stipulates that by 2030, member states must ensure 

the presence of charging stations for heavy-duty vehicles every 60 kilometers in both 

directions along the core TEN-T network, with a minimum total power of 3,600 kW per 

area. While this requirement sets systematic deployment, the approach developed in this 

work allows for prioritizing locations with higher logistical appeal and anticipated demand, 

facilitating a phased and efficient implementation of the national plan. 

In this context, the points selected by the proposed model largely coincide with the most 

trafficked sections of the TEN-T network and, therefore, are suitable to be considered as the 

initial phases of the mandatory deployment envisioned by the EU. In particular, the 

following locations stand out as priorities due to their traffic volume, connectivity, and 

strategic value.  

4.6 COST SENSITIVITY ANALYSIS ACCORDING TO THE 

PENETRATION RATE OF ELECTRIC TRUCKS 

Given the current uncertainty surrounding the future adoption rate of electric heavy-duty 

vehicles, a sensitivity analysis has been conducted to estimate how different market 

penetration scenarios would affect infrastructure needs and investment requirements. 
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Although projections suggest that a 7% penetration rate is a likely scenario by 2030, the 

exact rate remains uncertain. Therefore, it is useful to assess the implications of alternative 

adoption levels. The following table summarizes the total infrastructure cost for different 

penetration rates: 

 

% of electric 
trucks 

Total Cost 

5% 16.357.280 
7% 22.076.560 

10% 29.587.680 
15% 42.983.100 

Table 4.Cost sensitivity analysis according to the penetration rate of electric trucks 

 

As seen in Table 4.Cost sensitivity analysis according to the penetration rate of electric 

trucks, infrastructure costs rise proportionally to the increase in electric truck penetration. 

While a 5% adoption rate would entail a total cost of approximately €16.36 million, 

expanding this figure to a 15% penetration scenario would nearly triple the investment, 

surpassing €42.98 million.  

These costs reflect the scenario in which the charging station network was optimally sized 

and placed to meet demand effectively while preventing oversizing and redundant 

infrastructure overlap. Therefore, the economic feasibility and efficiency remain robust even 

at higher levels of adoption, making the proposed plan scalable and economically sustainable 

for anticipated future growth scenarios. 

Further detailed information, including the specific breakdown per station and the number 

of chargers required at each station according to each penetration scenario (5%, 7%, 10%, 

and 15%), is provided in the Annexes. 
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Chapter 5.  CONCLUSIONS AND FUTURE WORK 

This Master’s Thesis has addressed the challenge of planning an electric charging 

infrastructure for heavy-duty trucks in the Mediterranean Corridor, one of the most important 

freight routes in Spain and Europe. The methodology developed throughout the project 

integrates spatial data analysis, optimization models, and technical dimensioning, resulting 

in a proposal that is both robust and practical for real-world implementation. 

One of the key conclusions is that effective infrastructure planning requires prioritization. 

Rather than attempting to deploy stations everywhere at once, the use of demand-driven 

models allows for the identification of the most strategic locations. This approach ensures 

that resources are invested where they will have the greatest impact in terms of coverage, 

operational efficiency, and regulatory compliance. 

Another important lesson is the need for flexibility and scalability. The sensitivity analysis 

performed in this study shows that the network can be deployed in phases, beginning with 

an initial investment to meet a 5% electric truck penetration rate, and scaling up as adoption 

increases. This incremental approach reduces the risk of overinvestment and allows for the 

integration of new data as the sector evolves. 

The integration of technical, regulatory, and economic considerations from the outset has 

proven essential. By aligning the proposal with AFIR requirements and incorporating 

detailed cost analysis, the study ensures that the resulting plan is not only technically 

feasible, but also financially realistic and compliant with European policy. 

The results demonstrate that with careful planning, it is possible to design a charging network 

that covers the most critical logistics segments, minimizes unnecessary overlaps, and 

provides a solid foundation for the electrification of road freight transport. In total, 12 

optimal charging stations were selected along the Mediterranean Corridor. Under a 7% 

electric truck adoption scenario, the network would require 55 fast chargers and 8 slow 

chargers, with an estimated total infrastructure cost of €22,076,560. The proposed 
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methodology—combining spatial analysis, optimization, and technical modeling—can be 

adapted for other corridors or regions, serving as a reference for future infrastructure 

projects.In summary, this project confirms that the transition to electric heavy-duty vehicles 

is achievable if supported by rigorous analysis, phased investments, and coordination 

between public and private stakeholders. The experience gained during this research 

highlights the value of using open data, advanced modeling tools, and clear regulatory 

guidelines to support effective decision-making in transport infrastructure. 

As freight transport continues to evolve, ongoing monitoring and adaptation will be required. 

Future updates to the model could include real-time data, more detailed grid constraints, or 

varying consumption rates depending on route characteristics. What is clear is that a well-

planned, adaptable, and demand-driven infrastructure will be key to meeting both national 

and European sustainability goals. 

5.1 FUTURE LINES OF WORK 

Looking ahead, there are several directions in which this work can be expanded and 

improved to provide even greater value to decision-makers and industry stakeholders. One 

important avenue is the integration of real-world electrical grid constraints into the planning 

model. By considering the actual capacity and connection possibilities of the power grid at 

each selected location, future studies could ensure that proposed stations are not only optimal 

in terms of logistics, but also feasible from an energy supply perspective. 

Another area for further research is the refinement of demand estimation methods. 

Incorporating more detailed data on truck energy consumption—accounting for factors such 

as route topography, average loads, and different driving cycles—would make it possible to 

adjust infrastructure sizing more accurately to real operational needs. This would help to 

avoid both under-dimensioning, which could result in bottlenecks, and over-dimensioning, 

which would increase costs unnecessarily. 

Additionally, the current model assumes fixed adoption rates for electric trucks, but the 

reality is likely to be more dynamic. Developing a framework to simulate the progressive 
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growth of the electric truck fleet over time would enable planners to forecast when and where 

additional charging capacity will be needed, and to schedule investments accordingly. This 

type of dynamic modeling would also be useful for assessing the resilience of the network 

to sudden changes in demand or market conditions.  

There is also significant potential for enhancing the user experience at charging stations. 

Future work could explore the integration of additional services, such as overnight rest 

facilities, maintenance, or logistics support, transforming charging stations into 

comprehensive hubs for drivers and operators. Finally, aligning the prioritization of station 

deployment with available funding mechanisms and broader sustainability policies at the 

national and European levels will be crucial for ensuring the financial viability and long-

term success of the infrastructure. 

Importantly, the approach and tools developed here are not limited to the Mediterranean 

Corridor. The methodology can be readily expanded and adapted to other logistics corridors, 

regions, or even countries, both within Spain and across Europe. By following the same 

principles, combining empirical traffic data, spatial modeling, and economic analysis, 

planners can identify optimal locations and size infrastructure to support the wider transition 

to zero-emission freight transport. 

In conclusion, this work provides not only a roadmap for deploying electric truck charging 

stations in one of Spain’s main freight corridors, but also a replicable framework that can 

inform similar efforts in other territories. Success in this transition will depend on rigorous 

planning, coordination among stakeholders, and ongoing adaptation as technologies and 

market conditions change. 
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APPENDIX I 

ELECTRIC TRUCK CHARGING STATION INFRASTRUCTURE SUMMARY 

Code 9 

[1]  

Coordinates 41.4668,1.9781 

Road AP-7 

Exit 594 

Permanent 

monitoring 

station 
B-42-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 6 2.364.000 Fast chargers 8 3.152.000 

Slow chargers 2 101.640 Slow chargers 4 203.280 

  2.465.640   3.355.280 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 11 4.334.000 Fast chargers 16 6.304.000 

Slow chargers 8 406.560 Slow chargers 14 711.480 

  4.740.560   7.015.480 
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Code 7 

 

Coordinates 41.5923,2.3115 

Road C-17 

Exit 13 

Permanent 

monitoring 

station 
B-28-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 3 1.182.000 Fast chargers 4 1.576.000 

Slow chargers 0  Slow chargers 0  

  1.182.000   1.576.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 5 1.970.000 Fast chargers 7 2.758.000 

Slow chargers 0  Slow chargers 3 152.460 

  1.970.000   2.910.460 
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Code 3 

 

Coordinates 41.9292,2.7845 

Road A-2 

Exit 708 

Permanent 

monitoring 

station GI-20-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 5 1.970.000 Fast chargers 7 2.758.000 

Slow chargers 2 101.640 Slow chargers 2 101.640 

  2.071.640   2.859.640 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 9 3.546.000 Fast chargers 13 5.122.000 

Slow chargers 7 355.740 Slow chargers 13 660.660 

  3.901.740   5.782.660 

 

 

 

  



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

88 

 

Code 17 

 

Coordinates 41.6479,2.4253 

Road AP-7 

Exit 11 

Permanent 

monitoring 

station 
B-26-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 4 1.576.000 Fast chargers 6 2.364.000 

Slow chargers 0  Slow chargers 0  

  1.576.000   2.364.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 8 3.152.000 Fast chargers 11 4.334.000 

Slow chargers 0  Slow chargers 4 203.280 

  3.152.000   4.537.280 
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Code 1 

 

Coordinates 42.2989,2.9374 

Road AP-7 

Exit 3 

Permanent 

monitoring 

station 
GI-13-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 2 788.000 Fast chargers 3 1.182.000 

Slow chargers 0 0 Slow chargers 0  

  788.000   1.182.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 4 1.576.000 Fast chargers 5 1.970.000 

Slow chargers 0  Slow chargers 2 101.640 

  1.576.000   2.071.640 
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Code 29 

 

Coordinates 38.3695,-0.7045 

Road A-31 

Exit 220 

Permanent 

monitoring 

station A-536-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 5 1.970.000 Fast chargers 7 2.758.000 

Slow chargers 0  Slow chargers 0  

  1.970.000   2.758.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 9 3.546.000 Fast chargers 14 5.516.000 

Slow chargers 4 203.280 Slow chargers 4 203.280 

  3.749.280   5.719.280 
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Code 13 

 

Coordinates 39.4715,-0.6455 

Road A-3 

Exit 337 

Permanent 

monitoring 

station 
V-385-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 5 1.970.000 Fast chargers 7 2.758.000 

Slow chargers 0  Slow chargers 0  

  1.970.000   2.758.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 9 3.546.000 Fast chargers 13 5.122.000 

Slow chargers 2 101.640 Slow chargers 6 304.920 

  3.647.640   5.426.920 
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Code 14 

 

Coordinates 41.6669,1.2112 

Road A-2 

Exit 517 

Permanent 

monitoring 

station 

L-200-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 2 788.000 Fast chargers 3 1.182.000 

Slow chargers 0  Slow chargers 0  

  788.000   1.182.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 3 1.182.000 Fast chargers 4 1.576.000 

Slow chargers 0  Slow chargers 0 0 

  1.182.000   1.576.000 

 

 

 

 

 

  



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

93 

 

Code 10 

 

Coordinates 41.1367,1.2219 

Road A-7 

Exit 1153 

Permanent 

monitoring 

station T-61-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 3 1.182.000 Fast chargers 4 1.576.000 

Slow chargers 0  Slow chargers 0  

  1.182.000   1.576.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 5 1.970.000 Fast chargers 7 2.758.000 

Slow chargers 1 50.820 Slow chargers 3 152.460 

  2.020.820   2.910.460 
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Code 11 

 

Coordinates 39.6501,-0.3016 

Road V-23 

Exit 2 

Permanent 

monitoring 

station 
V-83-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 2 788.000 Fast chargers 2 788.000 

Slow chargers 0  Slow chargers 0  

  788.000   788.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 3 1.182.000 Fast chargers 4 1.576.000 

Slow chargers 0  Slow chargers 0  

  1.182.000   1.576.000 
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Code 2 

 

Coordinates 40.4592,0.4065 

Road AP-7 

Exit 42 

Permanent 

monitoring 

station 

CS-145-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 2 788.000 Fast chargers 2 788.000 

Slow chargers 0  Slow chargers 2 101.640 

  788.000   889.640 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 3 1.182.000 Fast chargers 4 1.576.000 

Slow chargers 2 101.640 Slow chargers 6 304.920 

  1.283.640   1.880.920 
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Code 24 

 

Coordinates 40.089,-0.0074 

Road AP-7 

Exit 45 

Permanent 

monitoring 

station 

CS-113-0 

 

Charging Infrastructure and Cost under Different EV Truck Penetration Scenarios for this 

station 

5% EV truck share 7% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 2 788.000 Fast chargers 2 788.000 

Slow chargers 0  Slow chargers 0  

  788.000   788.000 

      

10% EV truck share 15% EV truck share 

 Units Cost (€)  Units Cost (€) 

Fast chargers 3 1.182.000 Fast chargers 4 1.576.000 

Slow chargers 0  Slow chargers 0  

  1.182.000   3.355.280 
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PYTHON SCRIPT TO CREATE LINES BETWEEN COORDINATES 

# QGIS script to create line geometry from coordinates X_A, Y_A, X_B, Y_B 

# Runs in QGIS Python Console 

from qgis.core import ( 

    QgsProject, 

    QgsVectorLayer, 

    QgsFeature, 

    QgsGeometry, 

    QgsPointXY, 

    QgsField, 

    QgsFields, 

    QgsVectorFileWriter, 

    QgsWkbTypes, 

    QgsCoordinateReferenceSystem 

) 

from PyQt5.QtCore import QVariant 

 

# Path of the loaded CSV file (without geometry) 

layer = iface.activeLayer()  # select the active layer 

 

# Create a new line-type layer 

output_path = "C:/Users/Juan/Documents/TruckFlows.shp"  # change this path if 

necessary 

crs = QgsCoordinateReferenceSystem("EPSG:4326") 

fields = layer.fields() 

 

new_fields = QgsFields() 

for field in fields: 

    new_fields.append(field) 

 

writer = QgsVectorFileWriter( 

    output_path, 

    "UTF-8", 

    new_fields, 

    QgsWkbTypes.LineString, 

    crs, 

    "ESRI Shapefile" 

) 

 

for feat in layer.getFeatures(): 

    x1 = feat["X_A"] 

    y1 = feat["Y_A"] 

    x2 = feat["X_B"] 

    y2 = feat["Y_B"] 

 

    if None in (x1, y1, x2, y2): 

        continue  # skip if there are null values 

 

    point1 = QgsPointXY(float(x1), float(y1)) 

    point2 = QgsPointXY(float(x2), float(y2)) 

    geom = QgsGeometry.fromPolylineXY([point1, point2]) 

 



UNIVERSIDAD PONTIFICIA COMILLAS 

ESCUELA TÉCNICA SUPERIOR DE INGENIERÍA (ICAI) 
                                     MÁSTER UNIVERSITARIO EN INGENIERÍA INDUSTRIAL 

 

98 

    new_feat = QgsFeature() 

    new_feat.setFields(new_fields) 

    new_feat.setAttributes(feat.attributes()) 

    new_feat.setGeometry(geom) 

    writer.addFeature(new_feat) 

 

QgsProject.instance().addMapLayer(QgsVectorLayer(output_path, "Truck Flows", 

"ogr")) 

print("✔ Lines created successfully") 
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VBA SCRIPT THAT IDENTIFIES THE 12 OPTIMAL LOCATIONS  

'================ CONFIGURATION ===================================== 

Const NUM_SELECT        As Long   = 12 

Const RANGE_SCORE       As String = "Calculo!B2:B19" 

Const RANGE_IDS         As String = "Calculo!A2:A19" 

Const RANGE_DIST        As String = "Sheet1!B2:S19"   ' distances in meters 

Const OUTPUT_SHEET      As String = "Selected" 

 

' Parameters for dynamic λ 

Const LAMBDA_FACTOR     As Double = 1        ' 1 → full penalty 

Const RADIUS_KM         As Double = 10       ' radius of influence (km) 

Const RADIUS_M          As Double = RADIUS_KM * 1000 

'==================================================================== 

 

 

'============ MAIN MACRO: finds the optimal combination ============= 

Sub Optimal_12_Stations() 

 

    '--- load data --------------------------------------------------- 

    Dim vScore As Variant: vScore = Range(RANGE_SCORE).Value 

    Dim vIDs   As Variant: vIDs   = Range(RANGE_IDS).Value 

    Dim vDist  As Variant: vDist  = Range(RANGE_DIST).Value 

 

    '--- preparations for enumeration -------------------------------- 

    Dim idx(1 To 18) As Long, i As Long 

    For i = 1 To 18: idx(i) = i: Next i          ' indices 1…18 

 

    Dim sel(1 To NUM_SELECT) As Long             ' current combination 

    Dim bestSel(1 To NUM_SELECT) As Long         ' best combination 

    Dim bestZ As Double: bestZ = -1E+99 

 

    Enumerate 1, 1, sel, idx, vScore, vDist, bestZ, bestSel, NUM_SELECT 

 

    '--- output result to sheet -------------------------------------- 

    Dim ws As Worksheet: Set ws = EnsureSheet(OUTPUT_SHEET) 

    ws.Cells.Clear 

    ws.Range("A1").Value = "Optimal ID" 

    For i = 1 To NUM_SELECT 

        ws.Cells(i + 1, 1).Value = vIDs(bestSel(i), 1) 

    Next i 

    ws.Range("C1").Value = "Optimal Score": ws.Range("C2").Value = bestZ 

End Sub 

 

 

'============= RECURSIVE ROUTINE WITH DYNAMIC λ ====================== 

Private Sub Enumerate(pos As Long, startIdx As Long, _ 

                      sel() As Long, idx() As Long, _ 

                      vScore As Variant, vDist As Variant, _ 

                      ByRef bestZ As Double, bestSel() As Long, _ 

                      N As Long) 

 

    Dim i&, j&, k&, benefit#, totalPen#, lambdaVal#, d# 
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    If pos > N Then 

        '-- 1) benefit and λ for combination --------------------- 

        For i = 1 To N: benefit = benefit + vScore(sel(i), 1): Next i 

        lambdaVal = LAMBDA_FACTOR * (benefit / N) * (RADIUS_M ^ 2) 

 

        '-- 2) accumulated penalty -------------------------------- 

        For i = 1 To N - 1 

            For j = i + 1 To N 

                d = vDist(sel(i), sel(j)) 

                If d <= 0 Or Not IsNumeric(d) Then d = 1E+99 

                totalPen = totalPen + lambdaVal / (d * d) 

            Next j 

        Next i 

 

        '-- 3) final score and optimal update --------------------- 

        Dim Z#: Z = benefit - totalPen 

        If Z > bestZ Then 

            bestZ = Z 

            For k = 1 To N: bestSel(k) = sel(k): Next k 

        End If 

 

    Else 

        '-- build the combination --------------------------------- 

        For i = startIdx To UBound(idx) - (N - pos) 

            sel(pos) = idx(i) 

            Enumerate pos + 1, i + 1, sel, idx, vScore, vDist, bestZ, bestSel, N 

        Next i 

    End If 

End Sub 

 

 

'==================== MINIMAL UTILITY (create sheet) ================== 

Private Function EnsureSheet(name As String) As Worksheet 

    On Error Resume Next 

    Set EnsureSheet = Worksheets(name) 

    If EnsureSheet Is Nothing Then 

        Set EnsureSheet = Worksheets.Add 

        EnsureSheet.Name = name 

    End If 

    On Error GoTo 0 

End Function 
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ALIGNMENT WITH THE SUSTAINABLE DEVELOPMENT GOALS 

(SDGS) 

This project is closely aligned with several of the Sustainable Development Goals (SDGs) 

established by the United Nations' 2030 Agenda, as it addresses the transition toward a 

cleaner, more efficient, and more resilient freight transport model (United Nations, 2015). 

In particular, it contributes to the following SDGs: 

SDG 7 – Affordable and Clean Energy 

The planning of a charging network for electric trucks promotes the use of electricity as an 

energy source in heavy transport, facilitating the gradual replacement of fossil fuels with 

cleaner and more sustainable alternatives. Although the project does not focus on energy 

generation, it contributes to ensuring access to modern and efficient energy systems. 

SDG 9 – Industry, Innovation and Infrastructure 

The project supports the development of sustainable and technologically advanced 

infrastructure, such as charging stations for heavy electric vehicles. It also applies 

optimization models and spatial analysis, fostering innovation in territorial planning. 

SDG 11 – Sustainable Cities and Communities 

The reduction in emissions resulting from the use of electric trucks has a direct impact on 

improving air quality and the urban environment. This contributes to creating healthier and 

more sustainable environments for populations located near logistics corridors. 

SDG 12 – Responsible Consumption and Production 

The project promotes more efficient use of energy resources and more streamlined logistics 

by proposing a charging network optimized according to actual demand. This planning 

supports more sustainable mobility and a reduced environmental impact across the supply 

chain. 
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SDG 13 – Climate Action 

By facilitating the transition to electric heavy transport, the project directly contributes to 

climate change mitigation, reducing greenhouse gas emissions from the logistics sector and 

aligning with European commitments to climate neutrality. 


		2025-07-22T16:28:27+0200
	PEREZ BRAVO MANUEL - 49114355V




